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1
Using the Calendar

About the training session calendar
The public training session calendar on your Training Center Web site provides 
information about all listed training sessions that are either scheduled or in 
progress. However, the training session calendar does not provide information 
about unlisted training sessions.

You can navigate the training session calendar to quickly find a listed training 
session—either on the current date or any date—using one of several calendar 
views. For example, you can view a list of training sessions for today’s date only or 
for an entire month. 

When viewing a list of training sessions, you can sort the list and refresh it at any 
time.

A training session remains on the training session calendar until the training session 
actually ends or the scheduled ending time passes, whichever comes later.

If you want to... See...

get an overview of using the calendar About the training session calendar on page 1

view the training session calendar Viewing the training session calendar on 
page 2

select a date on the training session calendar Selecting a date on the training session 
calendar on page 2

search for a training session on the training 
session calendar

Searching for a training session on the training 
session calendar on page 4

sort the training session calendar Sorting the training session calendar on page 4

refresh the training session calendar Refreshing the training session calendar on 
page 5

select a time zone on the training session 
calendar

Selecting a time zone on the training session 
calendar on page 6
1



Chapter 1: Using the Calendar
Viewing the training session calendar

You can open one of the following calendar views of all listed training sessions:

To open a calendar view of all scheduled training sessions:

1 On the navigation bar, expand Attend a Session to view a list of links.

2 Click  Live Sessions.

The Live Sessions page appears, displaying the training session calendar.

3 Click one of the tabs to navigate to different views of the training session 
calendar:

You can choose Today, Upcoming, Daily, Weekly, or Monthly.

Selecting a date on the training session calendar

You can view a list of scheduled training sessions for any date on the training session 
calendar.

To display a list of scheduled training sessions for the previous or next day:

1 If you have not already done so, open the training session calendar. For details, 
see Viewing the training session calendar on page 2.

2 On the Daily view on the Live Sessions page, do one of the following:

■ To display a list of meetings for the previous day, click the Previous Day 
button. 

■ To display a list of meetings for the next day, click the Next Day button.

For details about the options on the Daily view, see About the Daily view on 
page 9.

Today Contains a list of training sessions occurring on the current date, 
including all training sessions currently in progress and all 
scheduled training sessions that are not yet in progress.

Upcoming Contains a list of all upcoming scheduled training sessions.

Daily Contains a single list of all training sessions occurring on the current 
date.

Weekly Contains a list of scheduled training sessions for each day of the 
selected week.

Monthly Indicates on which dates training sessions are scheduled for the 
selected month.

Next DayPrevious Day
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To display a list of training sessions for a specific date, using the Today, Upcoming, 
Daily, or Weekly view:

1 If you have not already done so, open the training session calendar. For details, 
see Viewing the training session calendar on page 2.

2 On the Today, Upcoming, Daily, or Weekly tab on the Live Sessions page, click 
the Calendar icon. 

The Calendar window appears, showing the calendar for the current month.

3 Optional. Do any of the following:

■ To view the calendar for the previous month, click the Decrement Month 
button.

■ To view the calendar for the next month, click the Increment Month button.

■ To view the calendar for a specific month, in the drop-down list, select a 
month.

■ To view the calendar for a specific year, in the drop-down list, select a year.

4 Click the date for which you want to view a list of training sessions.

The Daily view for the date that you selected appears.

For details about the options on the view tabs, see About the Today view on 
page 6, About the Upcoming view on page 8, About the Daily view on page 9, or 
About the Weekly view on page 10.

To display a list of training sessions for a specific date, using the Monthly view:

1 If you have not already done so, open the training session calendar. For details, 
see Viewing the training session calendar on page 2.

2 Click the Monthly tab.

3 Optional. Do either of the following:

■ To view the Monthly view for the previous month, click the Previous Month 
button. 

■ To view the Monthly view for the next month, click the Next Month button.

Decrement Month

Year drop-down list

Increment Month

Month drop-down list
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4 Click a date for which you want to view a list of scheduled training sessions.

The Daily view appears for the date that you selected.

Note Only dates by which a green square or on-demand hands-on lab icon appears 
have at least one scheduled training session.

For details about the options on the Monthly view, see About the Monthly view 
on page 12.

Searching for a training session on the training 
session calendar

On the training session calendar, you can locate a training session by searching for 
text in the host’s name, training session topic, or training session agenda. You 
cannot search for a training session number.

To search for a training session: 

1 If you have not already done so, open the training session calendar. For details, 
see Viewing the training session calendar on page 2.

2 Type the text for which you want to search in the Search for box.

3 Click Go.

The Search Results page appears, listing all training sessions that contain the 
search text.

Sorting the training session calendar
By default, training session lists on the training session calendar are sorted by hours, 
in ascending order. However, you can sort the training session lists by any column:

Next MonthPrevious Month

Starting Time Sorts the training session list by hours, in ascending or descending 
order.

Topic Sorts the training session list alphabetically by topic, in ascending or 
descending order.

Host Sorts the training session list alphabetically by host name, in 
ascending or descending order.
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To sort the public training session calendar:

1 If you have not already done so, open the training session calendar. For details, 
see Viewing the training session calendar on page 2.

2 In a list of training sessions on the Today, Upcoming, Daily, or Weekly tab on 
the Live Sessions page, click the column heading by which you want to sort the 
training sessions.

The Ascending Sort indicator appears, and the training sessions are sorted by 
the column, in ascending order.

The Descending Sort indicator appears, and the training sessions are sorted 
by the column, in descending order.

Refreshing the training session calendar
Information about training sessions on the public training session calendar can 
change at any time. Thus, to ensure that you are viewing the most current training 
session information, you can refresh the training session calendar at any time.

To refresh the public training session calendar:

1 If you have not already done so, open the training session calendar. For details, 
see Viewing the training session calendar on page 2.

2 Click the Refresh button.

Duration Sorts the training session list by duration, in ascending or descending 
order.

Status Sorts the training session list by status, in ascending order (Start, 
Join, Attend lab, Join now, Registration, Full, Closed, Not 
started) or descending order (Not started, Closed, Full, 
Registration, Join now, Attend lab, Join, Start).

Indicates that you can join the live training session.

Indicates that this is an Audio Only training session.

Appears next to the Starting Time column to indicate that more 
training session dates are available. Click to get training session 
information, including the additional dates. 
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Selecting a time zone on the training session 
calendar

On the training session calendar, you can access your Preferences page to select the 
time zone in which you want to view training session times. Your site administrator 
specifies the default time zone that appears on the training session calendar. You 
may need to change the time zone, for example, if you are travelling and 
temporarily in another time zone.

To select a time zone on the public training session calendar:

1 If you have not already done so, open the training session calendar. For details, 
see Viewing the training session calendar on page 2.

2 Click the time zone link to the right of All training session times in.

The Preferences page appears.

3 In the Time zone drop-down list, select another time zone.

4 Click OK.

Note

■ Your time zone selection affects only your view of your Training Center Web 
site, not other users’ views.

■ If you have a user account, all training session invitations that you send 
automatically specify the training session’s starting time in the time zone that 
you selected.

■ If you select a time zone for which daylight saving time (DST) is in effect, your 
Training Center Web site automatically adjusts its clock for daylight saving time.

About the Today view

How to access this page

On your Training Center Web site, click Attend a Session > Live Sessions > Today 
tab.

What you can do here

The Today view lists the live training sessions and on-demand hands-on lab 
sessions that are scheduled for the present day, including those in process, those 
concluded, and those that have not yet begun.

The training session information displayed in the list can be sorted by clicking the 
column headings. For details, see Sorting the training session calendar on page 4.
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Options on this page

Option Description

Click the Calendar icon open the Calendar window for the current 
month. Click on any date to open its schedule.

Click the Refresh icon at any time to display the most current list of 
training sessions, as well as the current time.

The Ascending Sort indicator appears next to a column heading, and 
the training sessions are sorted by the column, in ascending order.

The Descending Sort indicator appears next to a column heading, 
and the training sessions are sorted by the column, in descending 
order.

Starting Time Lists the starting time for each scheduled training session.

Topic Lists the scheduled training sessions by name. Click the topic name 
to get training session information.

Presenter Lists the presenter for the training session.

Duration Lists the scheduled length of the training session.

Status Lists the current status of the training session:

■ Start—Indicates that the host can start the training session by 
clicking the link.

■ Join—Indicates that the host can join the scheduled meeting by 
clicking the link.

■ Attend Lab—Indicates that participants can join the on-demand 
hands-on lab session. Click the link to join the session.

■ Join now—Indicates that participants can currently join the 
meeting. Click the link to join the training session from the Join a 
Session page.

■ Registration—Indicates that registration is required for the training 
session. Click the link to register for the training session from the 
Registration page.

■ Full—Indicates that the registrant limit for the training session’s 
required registration has been reached.

■ Closed—Indicates that the deadline for the training session’s 
required registration has been reached.

■ Not started—Indicates that the training session has not yet begun.

■ Ended—Indicates that the session has been ended by the host.

Indicates that you can join the live training session.

Indicates that this is an Audio Only training session.

Appears next to the Date column to indicate that more training session 
dates are available.
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About the Upcoming view

How to access this page

On your Training Center Web site, click Attend a Session > Live Sessions > 
Upcoming tab.

What you can do here

The Upcoming view lists future live training sessions and on-demand hands-on lab 
sessions that are scheduled to start on a day other than the present day.

The training session information displayed in the list can be sorted by clicking the 
column headings. For details, see Sorting the training session calendar on page 4.

Options on this page

Option Description

Click the Calendar icon open the Calendar window for the current 
month. Click on any date to open its schedule.

Click the Refresh icon at any time to display the most current list of 
training sessions, as well as the current time.

The Ascending Sort indicator appears next to a column heading, and 
the training sessions are sorted by the column, in ascending order.

The Descending Sort indicator appears next to a column heading, 
and the training sessions are sorted by the column, in descending 
order.

Date Lists the date(s) of the training session or on-demand hands-on lab 
session.

Appears next to the Date column to indicate that more training session 
dates are available. Click to get training session information, including 
the additional dates. 

Starting Time Lists the starting time for each scheduled training session.

Topic Lists the scheduled training sessions by name. Click the topic name 
to get training session information.

Presenter Lists the presenter for the training session.
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About the Daily view

How to access this page

On your Training Center Web site, click Attend a Session > Live Sessions > Daily 
tab.

What you can do here

The Daily view lists the live training sessions and on-demand hands-on lab sessions 
that are scheduled for the present day. From the Daily view you can navigate to the 
previous or next day, or use the calendar to view the schedule for another day.

The training session information displayed in the list can be sorted by clicking the 
column headings. For details, see Sorting the training session calendar on page 4.

Options on this page

Status Lists the current status of the training session:

■ Start—Indicates that the host can start the training session by 
clicking the link.

■ Join—Indicates that the host can join the scheduled meeting by 
clicking the link.

■ Attend Lab—Indicates that participants can join the on-demand 
hands-on lab session. Click the link to join the session.

■ Join now—Indicates that participants can currently join the 
meeting. Click the link to join the training session from the Join a 
Session page.

■ Registration—Indicates that registration is required for the training 
session. Click the link to register for the training session from the 
Registration page.

■ Full—Indicates that the registrant limit for the training session’s 
required registration has been reached.

■ Closed—Indicates that the deadline for the training session’s 
required registration has been reached.

■ Not started—Indicates that the training session has not yet begun.

■ Ended—Indicates that the session has been ended by the host.

Indicates that this is an Audio Only training session.

Option Description

Option Description

Click the Previous Day icon to display a list of meetings for the 
previous day.

Click the Next Day icon to display a list of meetings for the next day.
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About the Weekly view

How to access this page

On your Training Center Web site, click Attend a Session > Live Sessions > Weekly 
tab.

Click the Calendar icon open the Calendar window for the current 
month. Click on any date to open its schedule.

Click the Refresh icon at any time to display the most current list of 
training sessions.

The Ascending Sort indicator appears next to a column heading, and 
the training sessions are sorted by the column, in ascending order.

The Descending Sort indicator appears next to a column heading, 
and the training sessions are sorted by the column, in descending 
order.

Time Lists the starting time for each scheduled training session.

Topic Lists the scheduled training sessions by name. Click the topic name 
to get training session information.

Host Lists the host for the training session.

Duration Lists the scheduled length of the training session.

Status Lists the current status of the training session:

■ Start—Indicates that the host can start the training session by 
clicking the link.

■ Join—Indicates that the host can join the scheduled meeting by 
clicking the link.

■ Attend Lab—Indicates that participants can join the on-demand 
hands-on lab session. Click the link to join the session.

■ Join now—Indicates that participants can currently join the 
meeting. Click the link to join the training session from the Join a 
Session page.

■ Registration—Indicates that registration is required for the training 
session. Click the link to register for the training session from the 
Registration page.

■ Full—Indicates that the registrant limit for the training session’s 
required registration has been reached.

■ Closed—Indicates that the deadline for the training session’s 
required registration has been reached.

■ Not started—Indicates that the training session has not yet begun.

■ Ended—Indicates that the session has been ended by the host.

Indicates that you can join the live training session.

Indicates that this is an Audio Only training session.

Option Description
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What you can do here

The Weekly view lists the live training sessions and on-demand hands-on lab 
sessions that are scheduled, but not ended for the selected week.

The training session information displayed in the list can be sorted by clicking the 
column headings. For details, see Sorting the training session calendar on page 4.

Options on this page

Option Description

Click the Previous Week icon to display a list of meetings for the 
previous week.

Click the Next Week icon to display a list of meetings for the next 
week.

Click the Calendar icon open the Calendar window for the current 
month. Click on any date to open its schedule.

Click the Refresh icon at any time to display the most current list of 
training sessions.

Date link Opens the Daily view, which shows the scheduled training sessions 
for the selected day.

The Ascending Sort indicator appears next to a column heading, and 
the training sessions are sorted by the column, in ascending order.

The Descending Sort indicator appears next to a column heading, 
and the training sessions are sorted by the column, in descending 
order.

Starting Time Lists the starting time for each scheduled training session.

Topic Lists the scheduled training sessions by name. Click the topic name 
to get training session information.

Host Lists the host for the training session.

Duration Lists the scheduled length of the training session.
11
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About the Monthly view

How to access this page

On your Training Center Web site, click Attend a Session > Live Sessions > 
Monthly tab.

What you can do here

The Monthly view shows when the live training sessions and on-demand hands-on 
lab sessions are scheduled in a monthly calendar view. You can navigate to a specific 
day or week within the current month, or navigate to the previous or next month.

Options on this page

Status Lists the current status of the training session:

■ Start—Indicates that the host can start the training session by 
clicking the link.

■ Join—Indicates that the host can join the scheduled meeting by 
clicking the link.

■ Attend Lab—Indicates that participants can join the on-demand 
hands-on lab session. Click the link to join the session.

■ Join now—Indicates that participants can currently join the 
meeting. Click the link to join the training session from the Join a 
Session page.

■ Registration—Indicates that registration is required for the training 
session. Click the link to register for the training session from the 
Registration page.

■ Full—Indicates that the registrant limit for the training session’s 
required registration has been reached.

■ Closed—Indicates that the deadline for the training session’s 
required registration has been reached.

■ Not started—Indicates that the training session has not yet begun.

■ Ended—Indicates that the session has been ended by the host.

Indicates that you can join the live training session.

Indicates that this is an Audio Only training session.

Option Description

Option Description

Click the Previous Month icon to display a list of training sessions for 
the previous month.

Click the Next Month icon to display a list of training sessions for the 
next month.
12
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Click the Refresh icon at any time to display the most current view of 
the month’s training sessions.

Week link Opens the Weekly view, which shows the scheduled training sessions 
for each day of the selected week.

Day link Opens the Daily view, which shows the scheduled training sessions 
for the selected day.

Appears on the calendar to indicate that one or more training sessions 
are scheduled on that day.

Appears on the calendar to indicate that one or more on-demand 
hands-on lab training sessions are scheduled on that day.

Option Description
13
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Setting up Training Manager

About setting up Training Manager 
To participate in a training session, you must set up Training Manager software on 
your computer. Once you schedule, start, or join a training session for the first time, 
your training session service Web site starts the setup process. However, to save 
time, you can set up Training Manager at any time before scheduling, starting, or 
joining a training session.

Setting up Training Manager

If you want to... See...

get an overview of setting up Training 
Manager

About setting up Training Manager on 
page 15

set up Training Manager for Windows Setting up Training Manager for Windows on 
page 17

remove Training Manager from your computer UninstallingTraining Manager on page 18

make sure your system can handle Universal 
Communications Format (UCF) media files 

Checking your system for UCF Compatibility 
on page 19

If you want to... See...

get an overview of system requirements System requirements for Training Manager for 
Windows on page 16

set up Training Manager for Windows Setting up Training Manager for Windows on 
page 17

check your system for UCF compatibility Checking your system for UCF Compatibility 
on page 19
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System requirements for Training Manager for Windows 

Review the minimum system requirements for installing Training Manager for 
Windows:

■  Microsoft Windows 98, ME (Millennium Edition), XP, NT, or 2000 

■ Intel or AMD Processor 400 MHz

■ 128MB RAM (256MB recommended)

■ Microsoft Internet Explorer 6, Mozilla 1.7, Firefox 1.0 or later, or Netscape 7

■ JavaScript and cookies enabled in the browser

■ 56K or faster Internet connection

Important If you want to share a presentation that was created using Microsoft 
PowerPoint 2002 for Windows XP, an Intel Celeron or Pentium 500 MHz or faster 
processor is highly recommended.

In most cases, your Web browser is set up properly for Training Manager. However, 
if you are unsure whether your Web browser's settings are correctly configured, or 
you encounter problems when setting up Training Manager, you can set up your 
Web browser according to the following instructions.

To set up Internet Explorer 6.x:

1 On the Tools menu, choose Internet Options. 

The Internet Options dialog box appears.

2 Click the Security tab.

3 Ensure that the Internet zone is selected.

4 Click Custom Level. 

The Security Settings dialog box appears.

5 In the Reset to drop-down list, ensure that Medium is selected.

If Medium is not already selected, select it, and then click Reset.

6 Click OK to return to the Security tab.

7 Click OK to close the Internet Options dialog box.

To set up Netscape Navigator 4.x or later:

1 On the Edit menu, choose Preferences.

2 Click Advanced. 

The Advanced dialog box appears

3 Ensure that the following options are selected:
16
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■ Enable Java

■ Enable JavaScript

■ Accept all cookies

4 Click OK.

Setting up Training Manager for Windows

Before installing Training Manager, ensure that your computer meets the 
minimum system requirements. For details, see System requirements for Training 
Manager for Windows on page 16.

If you are not using the Windows operating system, please refer to our FAQ, which 
includes information about setting up Training Manager on other operating 
systems. 

To go to the list of FAQs:

1 On your Training Center Web site, on the left navigation bar, click Assistance > 
Support.

2 On the Support page, scroll down to the Documentation section and click FAQ 
(Frequently Asked Questions).

A list of questions displays, arranged by topic. Look for your information about 
your operating system under Minimum System Requirements.

To set up Training Manager for Windows:

1 On the navigation bar, expand Set Up, and then click Training Manager.

The Set Up page appears.

2 Click Set Up.

3 If a security dialog box appears, do one of the following:

■ If you are installing Training Manager on Microsoft Internet Explorer, click 
Yes.

■ If you are installing Training Manager on Netscape Navigator, click Grant.

Setup continues. A progress message box appears, indicating the progress of 
setup.

Once setup is complete, the Setup Complete page appears.

4 Click OK.

You can now start, schedule, or join a training session.

Note

■ Alternatively, you can download the Training Manager for Windows Installer 
from the Support page on your Training Center Web site, and then install 
17
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Training Manager on your Web browser. This option is useful if your system 
does not allow you to install Training Manager directly from the Set Up page.

■ If you or another attendee plans to share Universal Communications Format 
(UCF) media files during a training session, you can verify that the required 
components are installed on your system to play the media files. For details, see 
Checking your system for UCF Compatibility on page 19.

UninstallingTraining Manager

About uninstalling Training Manager for Windows

You can easily uninstall or remove Training Manager for Windows on your 
computer.

Uninstalling Training Manager for Windows

1 Do one of the following:

■ For Windows 98, 2000, ME, or NT: On your computer's desktop, 
double-click My Computer, and then open the Control Panel folder.

■ For Windows XP: Click Start, and then click Control Panel.

2 Double-click Add/Remove Programs or Add or Remove Programs, depending 
on your computer's operating system.

A dialog box appears, showing a list of programs installed on your computer.

3 In the list, select WebEx.

4 Click Add/Remove or Change/Remove, depending on your computer's 
operating system.

A message appears, asking you to confirm that you want to remove the software.

5 Click Yes.

The Uninstall WebEx Software dialog box appears.

6 Select Training Manager.

7 Click Uninstall.

8 Once the software is removed, click Finish.

If you want to... See...

get an overview of removing Training 
Manager from your computer

About uninstalling Training Manager for 
Windows on page 18

remove Training Manager for Windows Uninstalling Training Manager for Windows on 
page 18
18
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Select an option to restart your computer now or later.

Checking your system for UCF Compatibility

If you intend to play or view Universal Communications Format (UCF) media files 
during the training session, either as a presenter or an attendee, you can verify that 
the following components are installed on your computer:

■ Flash Player, for playing a Flash movie or interactive Flash files

■ Windows Media Player for playing audio or video files

Checking your system is useful if you or another presenter plans to share a UCF 
multimedia presentation or standalone UCF media files.

To check your system for UCF compatibility:

1 On the navigation bar, do one of the following:

■ If you are a new training session service user, click New User?.

■ If you are already a training session service user, expand Set Up, the click 
Training Manager. 

2 Click Verify your rich media players.

3 Click the links to verify that the required players are installed on your computer.

Note The option to check your system for required rich media players is available 
only if your Training Center Web site includes the UCF option.
19
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Joining a Training Session

About Joining a Training Session
You can join the following types of training sessions:

■ Listed training session—A training session that appears on the list of training 
sessions page.

■ Unlisted training session—A training session that does not appear on the list of 
training sessions page.

If a training session host either invites you to a training session or approves your 
registration request for a training session, you receive an email message that 
includes instructions and a link that you can click to join the training session. The 
email message contains the training session password, unless the host has specified 
that passwords do not appear in email messages.

If you want to... See...

get an overview of joining a training session About Joining a Training Session on page 21

register for a training session Registering for a Training Session on page 22

download course material before the training 
session

Downloading Course Material Before the 
Training Session on page 24

join a listed training session Joining a Listed Training Session on page 26

join an unlisted training session Joining an Unlisted Training Session on 
page 28

obtain information about a scheduled training 
session

Obtaining Information About a Scheduled 
Training Session on page 30
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If you did not receive an email invitation or registration confirmation, you can join 
a training session that is currently in progress. You need not be an authorized user 
or log in to your Training Center Web site to join a training session, unless the host 
has specified that all training session attendees must have a user account. 

Note If you have not yet set up Training Manager on your computer, you can do 
so before joining a training session to avoid a delay. Otherwise, once you join a 
training session, your Training Center Web site automatically sets up Training 
Manager on your computer.

Registering for a Training Session
If a training session host invites you to register for a training session, you receive an 
invitation email message. The email message contains a link that you can click to 
register for the training session.

If you did not receive an email invitation to register for a training session, you can 
register for the session on the Live Sessions page on the Training Center Web site:

If registering for a training session requires a password, you must provide the 
password that the training session host gave to you.

Note If registration is required for a Recurring single-session class or a Multiple 
session course, you will be required to register for only one session. If you register 
again in a subsequent session, the previous registration will be canceled.

Registering for a Training Session from an Invitation Email 
Message

To register for a training session from an email invitation that you received, follow 
these steps:

1 Open your email invitation, then click the link.

2 On the Session Information page that appears, click Register.

3 If the Log In page appears, type your user name and password in the User name 
and Password boxes, respectively, then click Log In.

This page may appear if the host requires that you have a user account to register 
for and join the training session.

4 If the Register for: [Topic] page appears, and it asks for a registration password, 
provide the password that the training session host gave to you, then click OK.
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If the host invited you to the session, your invitation email message contains the 
registration password.

5 On the Register for [Topic] page that appears, provide the required information.

6 Click Register.

Once the host approves your registration, you receive a registration 
confirmation email message. You can then join the training session once it starts.

If the training session is already in progress, and the host has chosen to approve 
all registration requests automatically, you join the training session 
immediately.

Registering for a Training Session from the Live Sessions Page

To register for a training session from the list of sessions on your training session 
service Web site, follow these steps:

1 On the navigation bar, expand Attend a Session to view a list of links.

2 Click Live Sessions.

The Live Sessions page appears.

3 In the list of sessions, locate the training session for which you want to register.

Note You can register for only those training sessions with a status of Register.

To locate a training session quickly, you can

■ sort the list of sessions by clicking the column headings. For details, see 
Sorting the Live Sessions Page on page 32.

■ search for a training session. For details, see Searching for a Training Session 
on page 32.

4 Under Topic, click the name of the training session for which you want to 
register.

5 Click Register.

6 If the Log In page appears, type your user name and password in the User name 
and Password boxes, respectively, then click Log In.

This page may appear if the host requires that you have a user account to register 
for and join the training session.

If you do not have an account, select Continue without signing up and click 
Continue.

7 If the Register for: [Topic] page appears, and it ask for a registration password, 
provide the password that the training session host gave to you, the click OK.
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If the host invited you to the session, your invitation email message contains the 
registration password.

8 On the Register for: [Topic] page that appears, provide the required 
information.

9 Click Register.

Once the host approves your registration, you receive a registration 
confirmation email message. You can then join the training session once it starts. 

If the training session is already in progress, and the host has chosen to approve 
all registration requests automatically, you join the training session 
immediately.

10 Click OK.

Tips

■ You can obtain detailed information about a selected training session or its 
agenda before registering for it. For details, see Obtaining Information About a 
Scheduled Training Session on page 30.

■ You can display all training session times in another time zone. For details, see 
Selecting a Time Zone on the Live Sessions Page on page 33.

■ You can refresh the training calendar to ensure that you are viewing the most 
recent information. For details, see Refreshing the Live Sessions Page on page 33.

Downloading Course Material Before the Training 
Session

If your training instructor uploads course material to the Training Center Web site, 
you can download it before the training session.

To download course material:

1 On the navigation bar, expand Attend a Session to view a list of links.

2 To view a single list of all training sessions, click Live Sessions.

The Live Sessions page appears.

3 On the Live Sessions page, locate the training session for which you want to 
download course material.

To locate a training session quickly, you can do the following:

■ sort the list of training sessions by clicking the column headings.

■ display the calendar for another date by clicking the calendar icon.
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■ view the scheduled sessions for the current day, future sessions, daily, weekly, 
or monthly recurring sessions by clicking the tabs: Today, Upcoming, Daily, 
Weekly, and Monthly. The recurring sessions tabs appear only if recurring 
sessions have been scheduled.

■ search for a training session by its host or presenter name, session topic, or 
any text in the description or agenda.

4 Under Topic, click the name of the training session for which you want to 
download course material.

The Session Information page appears.

5 Optional. If the training session requires registration and you have not yet 
registered, do the following: click Register. 

6 On the registration page, complete all the required information and any 
optional information. Then click Register.

The Registration Confirmed page appears.

7 If no registration is required, or if you have already registered, enter the session 
password and click View Info to see the complete session information.

8 Next to Course Material, click the link for the file.

The File Download dialog box appears.

9 Click Save.

The Save As dialog box appears.

10 Choose a location at which to save the file. Click Save.

The file downloads to your selected location.

11 If applicable, download additional files.

12 Once you finish downloading files, click Close.

13 Click OK or GoBack. 

Note If the host has published a file in the Universal Communications Format 
(UCF), which has a .ucf extension, a security warning dialog box appears, asking 
you if you want to install WebEx software that caches, or stores, the file on your 
computer. Click Yes or OK to install the software. Once you download the UCF file, 
the software also downloads the UCF file to the C:\My WebEx 
Documents\Cache\[SessionNumber] folder on your computer, in addition to any 
other location that you specify. Once the session starts, the UCF file that you 
downloaded automatically opens in your Session window. During the session, you 
can view the file’s content much more quickly than if you did not previously 
download the file.
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Joining a Listed Training Session
If you received either an invitation or registration confirmation email message for 
a training session, you can join the session from the email message. Or, you can join 
a listed training session by locating it on training calendar on the Live Sessions page.

If the training session requires a password, you must provide the password that the 
training session host gave to you.

Joining a Listed Training Session from an Email Message

To join a listed training session from an invitation email message, follow these steps:

1 Open your invitation or registration confirmation email message, then click the 
link.

The Get Info page appears.

2 Type the password in the Session password box, then click OK.

3 On the Session Information page that appears, click Join Now.

4 If the Log In page appears, type your user name and password in the User name 
and Password boxes, respectively, then click Log In.

This page may appear if the training session host requires that you have a user 
account to attend the training session.

If you do not have an account, select Continue without signing up and click 
Continue.

5 On the Join Training Session [Topic] page that appears, provide the following 
information, as required:

■ Your name: Provide the name by which you want participants to identify you 
during the training session.

■ Email address: Provide your email address, in the following format:

name@your_company—for example, msmith@company.com

■ Session password: Required. Provide the password that appears in your 
invitation email message or that the training session host gave to you.

Note If the training session requires registration, a Register button appears on 
the page. If you have not yet registered for the training session, you must do so 
before you can join it.

6 Click OK.

The Session window appears.
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If the training session includes an integrated teleconference, the Join 
Teleconference dialog box appears. Follow the instructions in the dialog box to 
start the teleconference.

Joining a Listed Training Session from the Live Sessions Page

To join a listed training session from the Live Sessions page on your Training 
Center Web site, follow these steps:

1 On the navigation bar, expand Attend a Session to view a list of links.

2 Click Live Sessions.

The Live Sessions page appears.

3 In the calendar, locate the training session that you want to attend.

To locate a training session quickly, you can 

■ sort the list of training sessions by clicking the column headings. 

■ display the calendar for another date by clicking the calendar icon.

■ view the scheduled sessions in another calendar view by clicking the tabs: 
Today, Upcoming, Daily, Weekly, and Monthly.

■ search for a training session by its host or presenter name, session topic, or 
any text in the description or agenda.

4 Under Status, click Join Now for the training session that you want to attend.

5 If the Log In page appears, type your user name and password in the User name 
and Password boxes, respectively, then click Log In.

This page may appear if the training session host requires that you have a user 
account to attend the training session.

6 On the Join Training Session: [Topic] page that appears, provide the following 
information, as required:

■ Your name: Provide the name by which you want participants to identify you 
during the training session.

■ Email address: Provide your email address, in the following format:

name@your_company—for example, msmith@company.com

■ Session password: Required. Provide the password that appears in your 
invitation email message or that the training session host gave to you.

Note If the training session requires registration, a Register button appears on 
the page. If you have not yet registered for the training session, you must do so 
before you can join it.

7 Click OK.
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The Session window appears.

If the training session host has set up an integrated teleconference, the Join 
Teleconference dialog box appears. Follow the instructions in the dialog box to 
start the teleconference.

Tips

■ You can obtain detailed information about a selected training session or its 
agenda before registering for it. For details, see Obtaining Information About a 
Scheduled Training Session on page 30.

■ You can display all training session times in another time zone. For details, see 
Selecting a Time Zone on the Live Sessions Page on page 33.

■ You can refresh the training calendar to ensure that you are viewing the most 
recent information. For details, see Refreshing the Live Sessions Page on page 33.

Joining an Unlisted Training Session
To join an unlisted training session—that is, a training session that does not appear 
on the Live Sessions page—you must provide the training session number that the 
training session host gave to you.

If you received either an invitation or registration confirmation email message for 
a training session, you can join the session from the email message. You can also 
join the training session from your Training Center Web site.

Joining an Unlisted Training Session from an Email Message

To join an unlisted training session from an invitation email message that you 
received, follow these steps:

1 Open your invitation email message, then click the link.

2 If the Log In page appears, type your user name and password in the User name 
and Password boxes, respectively, then click Log In.

This page appears only if the training session host requires that you have a user 
account to attend the training session.

3 If the Get Info: [Topic] page appears, type the training session password in the 
Session password box, then click OK.

This page appears only if the training session requires a password. Your 
invitation email message contains the password.

4 On the Session Information [Topic] page, click Join Now.
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Note If the training session requires registration, a Register button appears on 
the page. If you have not yet registered for the training session, you must do so 
before you can join it.

5 On the Join [Topic] page, provide the following information, as required:

■ Your name: Provide the name by which you want participants to identify you 
during the training session.

■ Email address: Provide your email address, in the following format:

name@your_company—for example, msmith@company.com

■ Session password: Required. Provide the password that appears in your 
invitation email message or that the training session host gave to you.

6 Click OK.

The Session window appears.

If the training session host has set up a teleconference, the Join Teleconference 
dialog box appears. Follow the instructions in the dialog box to start the 
teleconference.

Joining an Unlisted Training Session from Your Training Center 
Web Site

To join an unlisted training session from your Training Center Web site, follow 
these steps:

1 On the navigation bar, expand Attend a Session to view a list of links.

2 Click Unlisted Session.

The Join an Unlisted Training Session page appears.

3 Type the session number that the host gave to you in the Session number box.

4 Click Join Now.

5 If the Log In page appears, type your user name and password in the User name 
and Password boxes, respectively, then click Log In.

This page may appear if the host requires that you have a user account to attend 
the training session.

6 On the Join Training Session [Topic] page that appears, provide the following 
information, as required:

■ Your name: Provide the name by which you want participants to identify you 
during the training session.

■ Email address: Provide your email address, in the following format:
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name@your_company—for example, msmith@company.com

■ Session password: Required. Provide the password that appears in your 
invitation email message or that the training session host gave to you.

Note If the training session requires registration, a Register button appears on 
the page. If you have not yet registered for the training session, you must do so 
before you can join it.

7 Click OK.

The Session window appears.

If the training session host has set up a teleconference, the Join Teleconference 
dialog box appears. Follow the instructions in the dialog box to start the 
teleconference.

Obtaining Information About a Scheduled Training 
Session

Before joining or registering for a training session, you can obtain information 
about it—such as its description, host, and other details; or its agenda. 

To obtain information about a training session:

1 On the navigation bar, expand Attend a Session to view a list of links.

2 Do one of the following:

■ To view all listed training sessions, click Live Sessions.

The Live Sessions page appears, displaying all the scheduled sessions and 
times.

■ To view the unlisted sessions that require a password, click Unlisted Sessions. 
Type the session number that the host gave to you in the Session number 
box.

The Unlisted Sessions page appears, displaying information for the unlisted 
session.

3 If necessary, in the All training session times in drop-down list, select the time 
zone in which you are currently located.

4 On the Live Sessions page, locate the training session for which you want to 
obtain information.

To locate a training session quickly, you can

■ sort the list of training sessions by clicking the column headings. 

■ display the calendar for another date by clicking the calendar icon.
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■ view the scheduled sessions in another calendar view by clicking the tabs: 
Today, Upcoming, Daily, Weekly, and Monthly.

■ search for a training session by its host or presenter name, session topic, or 
any text in the description or agenda.

5 Under Topic, click the name of the training session for you which want to obtain 
information.

The Session Information page appears.

6 Type the password that the training session host gave to you in the View Info 
box.

If you received an invitation email message, the invitation contains the 
password.

The Session Information page now shows complete information.

Finding a Training Session

About Using the Live Sessions Page

The Live Sessions page on your Training Center Web site provides information 
about all listed training sessions that are either scheduled or in progress. However, 
the Live Sessions page does not provide information about unlisted training 
sessions.

You can navigate the list of sessions to quickly find a listed training session. You can 
also sort the list of training sessions that appear on the page that you are viewing, 
and refresh the list at any time.

The Live Sessions page provides a list of all scheduled training sessions.

On this page, you can

■ search for a training session by its host or presenter name, session topic, or any 
text in the description or agenda

■ view the scheduled sessions for the current day, future sessions, daily, weekly, or 

If you want to... See...

get an overview of using the Live Sessions 
page

About Using the Live Sessions Page on 
page 31

search for a training session Searching for a Training Session on page 32

sort the Live Sessions page Sorting the Live Sessions Page on page 32

refresh the Live Sessions page Refreshing the Live Sessions Page on 
page 33

select a time zone on the Live Sessions page Selecting a Time Zone on the Live Sessions 
Page on page 33
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monthly recurring sessions by clicking the tabs: Today, Upcoming, Daily, 
Weekly, and Monthly

■ sort the list of training sessions by clicking the column headings

■ view the calendar and select another date on the calendar, using the Calendar 

pop-up window 

■ navigate forward and backward in the calendar, using the Next Day and 

Previous Day buttons  

■ join a training session in progress

■ obtain general information about a training session or a training session’s 
agenda

■ register for a training session that requires registration

Searching for a Training Session

On the Live Sessions page, you can locate a training session by searching for its host 
or presenter name, session topic, or any text in the description or agenda. You 
cannot search for a session number.

To search for a training session: 

1 If you have not already done so, open the list of sessions.

2 Type the text for which you want to search in the Search for box. 

3 Click Go. 

The Search Results page appears, listing all training sessions that contain the 
search text.

On the Search Results page, you can do the following:

■ Sort the Live Sessions page. For details, see Sorting the Live Sessions Page on 
page 32.

■ Join a listed training session. For details, see Joining a Listed Training Session on 
page 26.

■ Obtain information about a training session. For details, see Obtaining 
Information About a Scheduled Training Session on page 30.

Sorting the Live Sessions Page

By default, the Live Sessions page is sorted by hours, in ascending order. However, 
you can sort the list of sessions by any column, as follows:

■ Time—Sorts the list of sessions by hours, in ascending or descending order. 

■ Topic—Sorts the list of sessions alphabetically by topic, in ascending or 
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descending order. 

■ Host—Sorts the list of sessions alphabetically by presenter—that is, host—
name, in ascending or descending order.

■ Duration—Sorts the list of sessions by duration, in ascending or descending 
order. 

■ Status—Sorts the list of sessions by status, in ascending order (Registration, 
Full, Closed, Join Now, Not started) or descending order (Not started, Join 
Now, Closed, Full, Registration). 

To sort the list of sessions by ascending or descending order:

1 If you have not already done so, open the Live Sessions page.

2 Click the column heading by which you want to sort the list of sessions.

The Ascending Sort indicator appears, and the list of sessions is sorted by 

the column, in ascending order. 

3 Optional. To sort the list of sessions in descending order, click the column 
heading again. 

The Descending Sort indicator appears, and the list of sessions is sorted by 

the column, in descending order.

Refreshing the Live Sessions Page

Information about training sessions on the Live Sessions page can change at any 
time. Thus, to ensure that you are viewing the most current training session 
information, you can refresh the list of sessions.

To refresh the public list of sessions:

1 If you have not already done so, open the Live Sessions page.

2 Click the Refresh button. 

Selecting a Time Zone on the Live Sessions Page

On the Live Sessions page, you can access your Preferences page to select the time 
zone in which you want to view training session times. Your site administrator 
specifies the default time zone that appears on the list of sessions. You may need to 
change the time zone, for example, if you are travelling and temporarily in another 
time zone.

To select a time zone on the Live Sessions:

1 If you have not already done so, open the Live Sessions page.

2 Click the link under All training session times in.
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The Preferences page appears.

3 In the Time zone drop-down list, select another time zone.

4 Click OK.
34



4
Participating in an Integrated 
VoIP Conference

If you want to... See...

get an overview of participating in an 
Integrated VoIP conference

About participating in an Integrated VoIP 
conference on page 36

learn about system requirements for 
Integrated VoIP

System requirements for Integrated VoIP on 
page 36

use the Audio Setup Wizard for Integrated 
VoIP, to fine-tune your computer’s setting and 
specify the type of speakers and microphone 
you are using

Using the Audio Setup Wizard for Integrated 
VoIP on page 37

join an Integrated VoIP conference Joining an Integrated VoIP conference on 
page 37

adjust speaker or microphone volume for 
Integrated VoIP

Adjusting speaker or microphone volume for 
Integrated VoIP on page 39

specify the type of speaker and microphone 
setup you are using

Specifying your speaker and microphone 
setup on page 39

ask to speak in an Integrated VoIP conference Asking to speak in an Integrated VoIP 
conference on page 40

learn how to use your microphone to speak in 
an Integrated VoIP conference

Speaking in an Integrated VoIP conference on 
page 40

optimize voice transmission to prevent voice 
delay or “choppiness”

Optimizing voice transmission in an Integrated 
VoIP conference on page 43

mute and unmute your microphone during an 
Integrated VoIP conference

Muting and unmuting your microphone in an 
Integrated VoIP conference on page 43

leave an Integrated VoIP conference Leaving an Integrated VoIP conference on 
page 44
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About participating in an Integrated VoIP 
conference

Integrated VoIP is a voice-conferencing option that allows participants to speak to 
each other using voice over IP (VoIP)—an Internet–based telephony service—
rather than the telephone system. 

Depending on the option that the training session presenter chose for the 
Integrated VoIP conference, either one or two participants can speak at a time in 
the conference. The training session host or presenter determines who can speak by 
passing the microphone to a participant.

Once you join an Integrated VoIP conference, you can listen to the speaker in the 
conference. You can also do the following:

■ Adjust the volume for your speakers or microphone

■ Use the Audio Setup Wizard to fine-tune your computer’s settings for Integrated 
VoIP and specify the type of speakers and microphone you are using

■ Ask the training session host to pass the microphone to you so you can speak

■ Speak in the conference, using a microphone either directly attached to your 
computer or integrated with a headset

■ Mute and unmute your microphone, if you are the current speaker

■ Leave the conference at any time

Note To participate in an Integrated VoIP conference, you must use a computer 
that meets the system requirements for Integrated VoIP. For details, see System 
requirements for Integrated VoIP on page 36.

System requirements for Integrated VoIP
To participate in an Integrated VoIP conference, you must use a computer that 
meets the following system requirements:

■ a supported sound card

For a list of supported sound cards, refer to the Frequently Asked Questions page 
on your Training Center Web site. 

■ speakers or headphones

■ a microphone, if you want to speak during the conference
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Tip For better audio quality and greater convenience, use a computer headset with 
a high-quality microphone.

Using the Audio Setup Wizard for Integrated VoIP
Before you participate in an Integrated VoIP conference, you can use the Audio 
Setup Wizard to:

■ ensure that your microphone and speakers are set to their optimal volume levels

■ specify whether you are using speakers and a separate microphone, or a headset 
with an integrated microphone

To use the Audio Setup Wizard for Integrated VoIP:

1 On the Communicate menu, choose Integrated VoIP > Audio Setup Wizard.

The Audio Setup Wizard appears.

2 Follow the instructions in the wizard.

Note The Audio Setup Wizard is not available if you are already participating in an 
Integrated VoIP conference. However, you can temporarily leave the conference to 
use the wizard, and then rejoin the conference.

Joining an Integrated VoIP conference
When you join a training session that includes an Integrated VoIP conference, the 
Join Integrated VoIP message automatically appears on your screen:
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Click Yes to join the conference.

When you join an Integrated VoIP conference:

■ The Volume dialog box appears that you can use to adjust the speaker or 
microphone volume.

■ The Integrated VoIP indicator appears to the left of your name on the 
Participants panel. For example:

You cannot speak in the conference until the host passes the microphone to you.

Tip

■ Before joining an Integrated VoIP conference, use the Audio Setup Wizard to 
fine-tune your computer’s settings for Integrated VoIP. For details, see Using the 
Audio Setup Wizard for Integrated VoIP on page 37.

■ At any time during an Integrated VoIP conference, you can ask the training 
session host or presenter to pass the microphone to you. For details, see Asking 
to speak in an Integrated VoIP conference on page 40.

Integrated VoIP indicator
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Adjusting speaker or microphone volume for 
Integrated VoIP

If you are participating in an Integrated VoIP conference, you can adjust the 
volume for your speakers or microphone at any time.

To adjust the speaker or microphone volume:

1 If the Volume dialog box is not already open, on the Communicate menu, 
choose Integrated VoIP > Volume.

The Volume dialog box appears.

2 To increase or decrease volume, drag the speaker or microphone slider. 

3 Optional. To mute your speakers or microphone, select the appropriate Mute 
check box. 

Tip Before you join an Integrated VoIP conference, you can use the Audio Setup 
Wizard to optimize the volume levels for your microphone and speakers. For 
details, see Using the Audio Setup Wizard for Integrated VoIP on page 37.

Specifying your speaker and microphone setup
You can specify the type of speakers and microphone you are using in an Integrated 
VoIP conference. You can select one of the following:

■ Desktop speakers (default): Specifies that you are using speakers that are either 
attached to or built into your computer, and a separate microphone attached to 
your computer.

■ Headset: Specifies that you are using a headset with an integrated microphone.

To specify your speaker and microphone setup:

1 On the Communicate menu, choose Integrated VoIP > Options.

The Integrated VoIP Options dialog box appears.
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2 On the Personal Options tab, select your speaker and microphone setup.

3 Click OK.

Asking to speak in an Integrated VoIP conference
During an Integrated VoIP conference, you can indicate to the training session host 
and presenter that you want to speak. You can cancel a request to speak at any time.

To request to speak:

On the Participants panel, click Ask for Mic.

Training Manager places your request in the speaker queue. A number appears to 
right of your Integrated VoIP indicator, to indicate your position in the queue. For 
example:

To cancel a request to speak:

On the Participants tab, click Ask for Mic again.

The number to the right of your Integrated VoIP indicator is removed.

You are now a current speaker. For more information, see Speaking in an Integrated 
VoIP conference on page 40.

Speaking in an Integrated VoIP conference
If you are a current speaker in an Integrated VoIP conference, the method by which 
you speak depends on the speaker setup option that is currently selected for your 
Integrated VoIP session:

■ Desktop speakers (default): If this option is selected, the following appears in the 
bottom-right corner of your Session window:

The number indicates your position 
in the speaker queue
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Simply speak into your microphone.

■ Headset: If this option is selected, the following appears in the bottom-right 
corner of your Session window: 

Press the Ctrl key on your keyboard while speaking. Pressing this key mutes your 
speakers, thereby preventing your voice from echoing in the conference.

Tip

■ You can specify the type of speakers and microphone you are using at any time. 
For details, see Adjusting speaker or microphone volume for Integrated VoIP on 
page 39.

■ If participants experience voice delay or “choppy” voice transmission while you 
are speaking, you can optimize your transmission of audio. For details, see 
Optimizing voice transmission in an Integrated VoIP conference on page 43.

Checking the quality of your VoIP connection
If you are a current speaker in an integrated VoIP conference, you can check the 
quality of your connection—that is, the quality of your voice transmission to other 
participants.

You can check your connection on the Session window or on the floating icon tray 
in full-screen mode.

To check your VoIP connection on the Meeting window:

When the Session window is visible, you can check your connection on the status 
bar. The VoIP indicator shows the following connection states:

Good connection:

Fair connection:

Green indicates that your connection is 
good. Participants hear little or no delay in 
your voice transmission.
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Poor connection:

To check your VoIP connection in full-screen mode:

When using full-screen mode, you can check your VoIP connection on the floating 
icon tray. The VoIP indicator shows the following connection states:

Good connection:

Fair connection:

Poor connection:

Yellow indicates that your connection is 
fair. Participants might hear some delay 
in your voice transmission.

Red indicates that your connection is 
poor. Participants hear significant delay 
in your voice transmission.

Green indicates that your connection is 
good. Participants hear little or no delay in 
your voice transmission.

Yellow indicates that your connection is 
fair. Participants might hear some delay in 
your voice transmission.

Red indicates that your connection is poor. 
Participants hear significant delay in your 
voice transmission.
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Tip Usually, the cause of a fair or poor VoIP connection is a lack of capacity, or 
“bandwidth,” available for sending voice information over your network or the 
Internet. To improve your VoIP connection, you can try the following:

■ If you are sharing software, pause or stop sharing.

■ If you are sending video, close the Video panel.

■ Close any other applications on computer that might be using bandwidth for 
your Internet connection.

■ Avoid downloading files on your network or from the Internet while using 
Integrated VoIP.

■ Avoid browsing the Web while using Integrated VoIP.

Optimizing voice transmission in an Integrated 
VoIP conference

If you are speaking in an Integrated VoIP conference, you can optimize the 
transmission of your voice to reduce:

■ Voice delay

■ Choppiness or “jitter”

To optimize voice transmission:

1 On the Communicate menu, choose Integrated VoIP > Options.

The Integrated VoIP Options dialog box appears.

2 On the Personal Options tab, under Voice buffer length, drag the to adjust voice 
transmission.

3 The faster the transmission, the more likely participants will hear choppiness.

4 Click OK to close the Integrated VoIP Options dialog box.

Muting and unmuting your microphone in an 
Integrated VoIP conference

If you are the current speaker in an Integrated VoIP conference, you can mute or 
unmute your microphone at any time. However, if the host has muted your 
microphone, you cannot unmute it.

To mute your microphone:

1 On the Participants panel, select your name. 
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2 Click Mute.

The Muted indicator appears to the left of your name. For example:

To unmute your microphone:

1 On the Participants panel, select your name. 

2 Click UnMute.

The Unmuted indicator appears to the left of your name. For example:

Leaving an Integrated VoIP conference
During a training session, you can leave an Integrated VoIP conference without 
leaving the training session. You can rejoin the conference at any time.

To leave an Integrated VoIP conference:

On the Communicate menu, choose Integrated VoIP > Leave Conference.

To rejoin an Integrated VoIP conference:

On the Communicate menu, choose Integrated VoIP > Join Conference.

Muted indicator

Unmuted indicator
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Participating in a 
Teleconference

About participating in a teleconference
Once you join a teleconference, you can communicate with other participants in 
the teleconference. However, the training session host or presenter can mute your 
phone’s microphone at any time. 

As a participant in a teleconference, you can

■ Mute and unmute your phone’s microphone

■ Ask to speak, if the host or presenter has muted your microphone 

■ Determine who is speaking in the teleconference

■ Leave the teleconference at any time

If you want to... See...

get an overview of participating in a 
teleconference

About participating in a teleconference on 
page 45

join a teleconference Joining a teleconference on page 46

mute or unmute your phone’s microphone Muting and unmuting your microphone in a 
teleconference on page 47

ask to speak in a teleconference Asking to speak in a teleconference on 
page 48

leave a teleconference Leaving a teleconference on page 49
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Joining a teleconference
Once you join a training session, instructions for joining the teleconference 
automatically appear on your screen. The instructions differ, depending on 
whether the host set up a call-back teleconference or a call-in teleconference.

You can also display these instructions at any time during the training session.

Once you join a teleconference, the Teleconference indicator appears to the left of 
your name on the Participants panel. For example:

To join a call-back teleconference:

In a call-back teleconference, provide your phone number, and the automated 
system will call you and add you to the teleconference.

Tip If you are unable to join a call-back conference, you can dial the backup call-in 
number instead. This number appears:

■ In your invitation email message, if you received one

■ On the Info tab in your Session window

■ In the status bar at the bottom of your Session window

To join a call-in teleconference:

In a call-in teleconference, dial the appropriate number to join the teleconference.

Teleconference indicator
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Note If the global call-in numbers option is available, a list of international phone 
numbers appears on the Join Teleconference dialog box. Dial the appropriate 
number for your location, and then click OK to close the dialog box. For a list of 
toll-free calling restrictions by country, see 
www.webex.com/pdf/tollfree_restrictions.pdf.

To display teleconference instructions during a training session:

On the Communicate menu, choose Join Teleconference.

Muting and unmuting your microphone in a 
teleconference

In a teleconference, you can mute or unmute your microphone at any time. 
However, if the host or presenter has muted your microphone, you cannot unmute 
it.

To mute your microphone:

1 On the Participants panel, select your name. 

2 Click Mute.

The Muted indicator appears to the left of your name. For example:

To unmute your microphone:

1 On the Participants panel, select your name. 

Muted indicator
47

www.webex.com/pdf/tollfree_restrictions.pdf


Chapter 5: Participating in a Teleconference
2 Click UnMute.

The Unmuted indicator appears to the left of your name. For example:

Asking to speak in a teleconference
If the host has muted your microphone during a teleconference, you can ask the 
host to unmute your microphone so that you can speak. You can cancel a request 
to speak at any time.

To ask to speak:

On the Participants panel, click Raise Hand.

The Raised Hand indicator appears on the Participant panel for the host, presenter, 
and panelists.

To cancel a request to speak:

On the Participants panel, click Lower Hand.

The Raised Hand indicator is removed from the Participant panel for the host and 
presenter.

Determining who is speaking in a teleconference
During a teleconference, you can quickly determine which participants are 
speaking. When a participant speaks, the Teleconference indicator on the 
Participants panel animates. For example:

Unmuted indicator

Animated Teleconference indicator
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To ask to speak:

On the Participants panel, click the Raise Hand button.

The Raised Hand indicator appears on the Participant panel for the host, presenter, 
and panelists.

To cancel a request to speak:

On the Participants panel, click the Raise Hand button again.

The Raised Hand indicator is removed from the Participant panel for the host, 
presenter, and panelists.

Leaving a teleconference
During a training session, you can leave a teleconference without leaving the 
training session. You can also rejoin the teleconference at any time.

To leave a teleconference:

On the Communicate menu, choose Leave Teleconference.

To rejoin a teleconference:

On the Communicate menu, choose Join Teleconference.
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6
Working with Shared 
Documents, Presentations, and 
Whiteboards

About interacting with shared documents, 
presentations, and whiteboards

This section details how attendees can view and manipulate documents, 
presentation, and whiteboards that a presenter shows during a training session. 
Attendees can zoom in and back out on any document or whiteboard. If they spend 
time looking at something in detail, they can catch up by synchronizing their 
desktops with the presenter. If attendees have the privilege available, they can look 
at thumbnails for an entire presentation.

Viewing documents, presentations, or whiteboards

You can view any documents, presentations, or whiteboards that a presenter shares.

If you want to... See...

get an overview of working with documents, 
presentations, and whiteboards

About interacting with shared documents, 
presentations, and whiteboards on page 51

display another page, slide, or whiteboard Displaying pages, slides, or whiteboards on 
page 52

magnify a page or slide or a portion of it Zooming in or out on pages, slides, or 
whiteboards on page 53

catch up with the presenter, if you are 
reviewing an earlier part of a presentation

Synchronizing your view of pages, slides, or 
whiteboards on page 60
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All shared content appears in the content viewer in the Session window. 

A tab at the top of the content viewer appears for each document, presentation, or 
whiteboard in the viewer. 

Displaying pages, slides, or whiteboards

If you have been granted the necessary privileges, you can navigate to different 
pages, slides, or whiteboard “pages” in the content viewer. Each document, 
presentation, or whiteboard being shared appears on a at the top of the content 
viewer.

To display pages or slides in the content viewer:

1 In the Session window, in the content viewer, select the tab for the document, 
presentation, or whiteboard that you want to display.

If you have more tabs than can be displayed on the content viewer, click the 
down-arrow button at the end of the tabs to view the list of other tabs.

2 On the toolbar, click a button to change the page or slide you are viewing:

Tabs for documents 
currently available 
in the viewer

Click this button to view 
other tabs
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■ To display the next page or slide, click the Next button.

■ To display the previous page or slide, click the Previous button.

■ To display any page or slide, select it in the Go To drop-down list.

If Microsoft PowerPoint slides are being shared, the drop-down list also dis-
plays the title of each slide.

Note Alternatively, you can navigate to different pages or slides in a shared 
document, presentation, or whiteboard by opening the thumbnail viewer. For 
details, see Viewing miniatures of pages, slides, or whiteboards on page 58.

Zooming in or out on pages, slides, or whiteboards

You can magnify or reduce any page, slide, or whiteboard that appears in the 
content viewer, using various methods. Magnifying or reducing content in the 
content viewer changes only its appearance, not its actual size.

To learn about the zoom features, see:

■ Zooming in on a page, slide, or whiteboard incrementally on page 54.

■ Zooming in on a selected area on a page, slide, or whiteboard on page 54.

■ Zooming out on a page, slide, or whiteboard on page 55.

■ Displaying a page, slide, or whiteboard at a preset percentage on page 55.

■ Adjusting a page, slide, or whiteboard to fit the content viewer on page 56.

■ Adjusting a page, slide, or whiteboard to fit its width in the content viewer on 
page 57.

Next button

Previous button

Select a slide
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Zooming in on a page, slide, or whiteboard incrementally

To zoom in incrementally on a page, slide, or whiteboard in the content viewer in 
the Session window, perform one of these actions:

■ On the toolbar, click the downward-pointing arrow to the right of the Zoom 
In/Zoom Out button.

Then, on the menu that appears, choose Zoom In.

Training Manager increases the magnification of the page, slide, or whiteboard 
by the next higher preset percentage.

■ On the content viewer toolbar, click the Zoom In button.

Each time you click the Zoom In button, Training Manager increases the 
magnification of the page or slide by the next higher preset percentage.

■ On the View menu, choose Zoom In.

Training Manager increases the magnification of the page, slide, or whiteboard 
by the next higher preset percentage.

To turn off the zoom tool:

On the toolbar, click the Zoom In/Zoom Out button.

Zooming in on a selected area on a page, slide, or whiteboard

To zoom in:

1 On the toolbar, click the downward-pointing arrow to the right of the Zoom 
In/Zoom Out button.

Your mouse pointer changes to a magnifying glass. 

Click to display menu

Zoom In button

Zoom In button
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2 Click in the content viewer, and then drag your mouse over the area that you 
want to magnify. 

3 Release your mouse button.

4 Optional. To continue magnifying the area, repeat steps 2 and 3.

Your mouse pointer returns to its default state.

Zooming out on a page, slide, or whiteboard

To zoom out incrementally on a page, slide, or whiteboard in the content viewer in 
the Session window, choose one of these methods:

■ On the toolbar, click the downward-pointing arrow to the right of the Zoom 
In/Zoom Out button.

Then, on the menu that appears, choose Zoom Out.

Training Manager reduces the magnification of the page, slide, or whiteboard by 
the next lower preset percentage.

■ On the content viewer toolbar, click the Zoom Out button.

Each time you click the Zoom Out button, Training Manager reduces the 
magnification of the page or slide by the next lower preset percentage.

■ On the View menu, choose Zoom Out.

Training Manager reduces the magnification of the page, slide, or whiteboard by 
the next lower preset percentage.

Displaying a page, slide, or whiteboard at a preset percentage

To zoom in or out to a preset percentage on a page, slide, or whiteboard in the 
content viewer in the Session window, choose either method:

■ On the toolbar, click the downward-pointing arrow to the right of the Zoom 
In/Zoom Out button.

Zoom Out button

Zoom Out button
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Then, on the menu that appears, choose the percentage at which you want to 
view the page, slide, or whiteboard.

■ On the View menu, choose Zoom By.

Then, on the menu that appears, choose the percentage at which want to view 
the page, slide, or whiteboard.

Adjusting a page, slide, or whiteboard to fit the content viewer

To change the magnification of a page, slide, or whiteboard to fit the content viewer 
in the Session window, perform either task:

■ On the toolbar, click the downward-pointing arrow to the right of the Zoom 
In/Zoom Out button.

Then, on the menu that appears, choose Fit in Viewer.

Choose a percentage from this list
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■ On the View menu, choose Fit in Viewer.

Training Manager resizes the page, slide, or whiteboard to the magnification 
that allows its entire width and height to fit in the content viewer.

Adjusting a page, slide, or whiteboard to fit its width in the content 
viewer

To change the magnification of a page, slide, or whiteboard to fit its width in the 
content viewer in the Session window, choose either method:

■ On the toolbar, click the downward-pointing arrow to the right of the Zoom 
In/Zoom Out button.

Then, on the menu that appears, choose Fit to Width.

■ On the View menu, choose Fit to Width.

Choose Fit in Viewer

Choose Fit to Width
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Training Manager resizes the page, slide, or whiteboard to the magnification 
that allows its entire width.

Viewing miniatures of pages, slides, or whiteboards

For presenters and attendees who have the Thumbnails privilege

You can view miniatures, or thumbnails, of the shared pages, slides, and 
whiteboards that appear in the content viewer, by opening the thumbnail viewer. 
Viewing miniatures can help you to quickly locate a shared page or slide that you 
want to display in the content viewer.

To view miniatures of pages, slides, or whiteboards:

1 In the Session window, in the content viewer, select the tab for the document, 
presentation, or whiteboard for which you want to view miniatures.

2 Do either:

■ On the toolbar, click the View Thumbnails button.

■ On the View menu, choose Thumbnails. 

Miniatures of all pages or slides in the selected document, presentation, or 
whiteboard appear in the thumbnail viewer.

View Thumbnails button
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3 Optional. To display any page or slide in the content viewer, double-click its 
miniature.

4 Optional. To control the size of the thumbnail viewer, drag the right edge of the 
viewer to the right or left.

Note Attendees must also have the view any page privilege to display a miniature of 
a page or slide at full size in the content viewer.

To close the thumbnail viewer:

On the toolbar, click the View Thumbnails button again.

Controlling full-screen view of pages, slides, or whiteboards

You can maximize the size of a page, slide, or whiteboard in the content viewer to 
fit your monitor's entire screen. A full-screen view replaces the normal Session 
window view. You can return to a normal view at any time.

Thumbnails display here
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Note If a training session presenter displays a full-screen view of a page, slide, or 
whiteboard, attendees' screens automatically display a full-screen view as well. 
However, attendees can control full-screen view independently in their Session 
windows. 

To display a full-screen view:

In the Session window, perform either action:

■ On the toolbar, click the Full-Screen View button.

■ On the View menu, choose Full Screen.

The content viewer changes to a full-screen view.

To return to a normal view:

On the floating icon tray, click the Return to Main Window button.

The document, slide, or whiteboard reappears in the content viewer in the Session 
window.

Synchronizing your view of pages, slides, or whiteboards

During a training session, you can synchronize the display of shared content in your 
content viewer with the display in the presenter's viewer. This option is useful, for 
example, if you are viewing a previous slide in a presentation and want to quickly 
return to the actual slide that the presenter is discussing. Synchronizing your 
display also resizes it to that in the presenter's content viewer. 

To synchronize your view of shared content in the presentation viewer:

In the Session window, on the toolbar, click the Synchronize My Display button.

Full-Screen View button

Return to Main Window button
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Annotating presentations, documents, or 
whiteboards

About annotating shared presentations, documents, or 
whiteboards

If the presenter has granted you annotation privileges, you can annotate a shared 
document, presentation, or whiteboard that appears in the content viewer. When 
making annotations, you can:

■ Draw objects and highlight text or graphics

■ Type text

■ Select a font for typing

■ Select a color for annotations

■ Adjust an annotation color so it is visible on either a light or dark background

■ Clear or erase annotations

■ Undo and redo annotations

Synchronize My Display button

If you want to... See...

get an overview about annotating 
presentations, documents, or whiteboards

About annotating shared presentations, 
documents, or whiteboards on page 61

draw annotations on slides, pages, or 
whiteboards

Drawing annotations on slides, pages, or 
whiteboards on page 62

type annotations on pages or slides Typing annotations on slides, pages, or 
whiteboards on page 63

select a color for annotating slides, pages, or 
whiteboards

Selecting a color for annotating slides, pages, 
or whiteboards on page 64

make any annotation color visible on either a 
light or dark background in the content viewer

Making annotations visible on different 
backgrounds in the content viewer on page 64

select a font for typing annotations on slides, 
pages, or whiteboards

Selecting a font for annotating slides, pages, 
or whiteboards on page 64

undo or redo annotations in the content viewer Undoing and redoing changes in the content 
viewer on page 65
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Annotation tools

Drawing annotations on slides, pages, or whiteboards

Using the drawing tools, you can draw annotations on shared slides, pages, or 
whiteboards in the content viewer. The drawing tools allow you to highlight text 
and graphics; draw freehand; and draw lines, arrows, and various shapes.

Tool Description

Pointer Lets you point out text and graphics on shared content. The pointer displays 
an arrow with your name and annotation color. To display the laser pointer, 
which lets you point out text and graphics on shared content using a red “laser 
beam,” click the downward-pointing arrow. Clicking this button again turns off 
the pointer tool.

Text Lets you type text on shared content. Attendees can view the text once you 
finish typing it and click your mouse in the content viewer, outside the text box.

To change the font, on the Edit menu, choose Font. Clicking this button 
again turns off the text tool.

Line Lets you draw lines and arrows on shared content. For more options, click 
the downward-pointing arrow. Clicking this button closes the Rectangle 
tool.

Rectangle Lets you draw shapes, such as rectangles and ellipses on shared content. 
For more options, click the downward-pointing arrow. Clicking this button 
again closes the Rectangle tool.

Highlighter Lets you highlight text and other elements in shared content. For more 
options, click the downward-pointing arrow. Clicking this button again 
closes the Highlighter tool

Annotation 
Color

Displays the Annotation Color palette, on which you can select a color to 
annotate shared content. Clicking this button again closes the Annotation 
Color palette.

Eraser Erases text and annotations or clears pointers on shared content. To erase a 
single annotation, click it in the viewer. For more options, click the 
downward-pointing arrow. Clicking this button again turns off the eraser tool.

Text tool Rectangle tool

Eraser tool

Annotation Color tool

Line toolPointer tool Highlighter tool

Highlighter tool
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To highlight an element on a page, slide, or whiteboard:

1 On the toolbar, click the Highlighter Tool icon.

2 To draw annotations, drag your mouse.

3 Optional. Click the downward pointing arrow next to the Highlighter tool to 
select a different highlighting tool.

Note You can change your annotation color at any time. For details, see Selecting a 
color for annotating slides, pages, or whiteboards on page 64.

To turn off the drawing tool:

On the toolbar, click the Highlighter Tool icon.

Typing annotations on slides, pages, or whiteboards

Using the text tool, you can type annotations on shared slides, pages, or 
whiteboards in the content viewer.

To type annotations on a page, slide, or whiteboard:

1 On the toolbar, click the Text Tool icon.

Your mouse pointer changes to a cursor.

2 Begin typing in the content viewer.

3 Click outside the box in which you typed the text to send the text to all 
participants' content viewers.

Note When typing annotations, you can do the following:

■ Select a different font. For details, see Selecting a font for annotating slides, pages, 
or whiteboards on page 64.

■ Select a different annotation color. For details, see Selecting a color for annotating 
slides, pages, or whiteboards on page 64.

To turn off the text tool:

On the toolbar, click the Text Tool icon.

Text tool
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Selecting a color for annotating slides, pages, or whiteboards

You receive a default annotation color when you join a training session. However, 
you can select a different color for making annotations.

To select a color for annotating a shared page, slide, or whiteboard:

1 On the toolbar, click the Annotation Color icon.

The Annotation Color palette appears.

2 Select the color that you want to use.

Making annotations visible on different backgrounds in the 
content viewer

When using annotation tools to annotate a document, presentation, or whiteboard 
in the content viewer, you can adjust your annotation color so it displays well on 
either a light or dark background. For example, if you are using a dark annotation 
color to annotate a dark image on a slide, you can make your annotations visible on 
the dark image.

To annotate on either a light or dark background in the content viewer:

1 On the Edit menu, choose Annotate On.

2 Choose a background:

■ Light Background—Makes annotations visible on a light background.

■ Dark Background—Makes annotations visible on a dark background.

Selecting a font for annotating slides, pages, or whiteboards

When typing text on a page, slide, or whiteboard in the content viewer, you can 
select the:

■ Font

■ Font style

■ Text color

To select a font for typing annotations:

1 On the Edit menu, choose Font.

The Font dialog box appears.

Annotation Color tool
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2 Select the font and other options that you want to use.

3 Click OK.

Undoing and redoing changes in the content viewer

When annotating a page, slide, or whiteboard in the content viewer, you can undo 
and redo up to ten changes that you made.

To undo and redo changes in the content viewer:

1 On the Edit menu, choose Undo.

2 Optional. Repeat step 1 to undo another change.

3 If you decide that you do not want to undo your change, on the Edit menu, 
choose Redo.

Using pointers on presentations, documents, or 
whiteboards

About using pointers on shared presentations, documents, or 
whiteboards

When sharing or viewing a document, presentation, or whiteboard, you can use 
either type of pointer:

■ Arrow pointer: Shows your assigned annotation color and your name. You can 
click your mouse to set the pointer at specific location on a page, slide, or 
whiteboard.

■ Laser pointer: Shows a red “laser” dot that you can move continuously on a 
page, slide, or whiteboard, using your mouse.

You can remove or clear your pointer from a page, slide, or whiteboard at any time.

If you want to... See...

get an overview on using pointers on shared 
presentations, documents, or whiteboards

About using pointers on shared presentations, 
documents, or whiteboards on page 65

use an arrow pointer to highlight areas on 
slides, pages, or whiteboards

Using an arrow pointer on slides, pages, or 
whiteboards on page 66

use a laser pointer to highlight areas on slides, 
pages, or whiteboards

Using a laser pointer on slides, pages, or 
whiteboards on page 66

clear a pointer from pages, slides, or a 
whiteboard

Clearing pointers on slides, pages, or 
whiteboards on page 67
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Using an arrow pointer on slides, pages, or whiteboards

When sharing or viewing a page, slide, or whiteboard in the content viewer, you can 
add an arrow pointer to emphasize text or graphics. Your pointer provides your 
name and default annotation color.

To use an arrow pointer to a page, slide, or whiteboard:

1 On the toolbar, select the Pointer Tool icon.

Your mouse pointer becomes an arrow.

2 Click the location on the page, slide, or whiteboard at which you want to add a 
pointer.

3 To move the pointer, click another location on the page, slide, or whiteboard.

To turn off the pointer tool:

On the toolbar, click the Pointer Tool icon.

Note When you turn off the pointer tool, your pointer remains on the page, slide, 
or whiteboard. For instructions on removing, or clearing, your pointer, see Clearing 
pointers on slides, pages, or whiteboards on page 67.

Using a laser pointer on slides, pages, or whiteboards

When sharing a page, slide, or whiteboard in the content viewer, you can use a laser 
pointer tool, which allows you to quickly move a “laser beam” to different areas of 
the shared content. The laser pointer is useful for guiding attendees from one part 
of a page or slide to another. 

To use a laser pointer on a page, slide, or whiteboard:

1 On the toolbar, click downward-pointing arrow next to the Pointer tool icon.

2 Select the Laser Pointer.

Pointer tool

Click to display list of 
Pointer tools
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Your mouse pointer becomes a red “laser beam.”

3 To move the pointer, move your mouse, without clicking it.

To turn off the laser pointer tool:

On the toolbar, click the Pointer tool icon.

Clearing pointers on slides, pages, or whiteboards

You can clear your own pointers on all shared slides, pages, or whiteboards in the 
content viewer. 

To clear your own pointer on all shared slides, pages, or whiteboards: 

1 On the toolbar, click the downward-pointing arrow to the right of the Eraser 
Tool icon.

2 Choose Clear My Pointer.

Saving, opening, and printing presentations, 
documents, or whiteboards

Saving a presentation, document, or whiteboard

If the presenter has granted you the Save document privilege, you can save any 
shared document, presentation, or whiteboard that appears in the content viewer. 
A saved file contains all the pages or slides in the document, presentation, or 
whiteboard that is currently displayed in the content viewer, including any 
annotations and pointers that you or other attendees added to them.

Click to display Eraser tools

If you want to... See...

save a shared document, presentation, or 
whiteboard to a file

Saving a presentation, document, or 
whiteboard on page 67

open a saved document, presentation, or 
whiteboard, either in a training session or 
outside of a training session

Opening a saved document, presentation, or 
whiteboard on page 68

print a shared document, presentation, or 
whiteboard that appears in the content viewer

Printing presentations, documents, or 
whiteboards on page 69
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Files that you save are in the Universal Communications Format (UCF), which 
have a .ucf extension. You can open a .ucf file either in another training session 
or at any time outside of a training session. 

Once you save a new document, presentation, or whiteboard to a file, you can save 
it again to overwrite the file or save a copy to another file.

To save a new document, presentation, or whiteboard that appears in the content 
viewer:

1 On the File menu, choose Save > Document.

The Save Document As dialog box appears.

2 Choose a location at which to save the file.

3 Type a name for the file in the File name box.

To save changes to a saved document, presentation, or whiteboard that appears in 
the content viewer:

1 On the File menu, choose Save > Document.

Meeting Manager saves the changes to the existing file.

To save a copy of a document, presentation, or whiteboard: 

1 On the File menu, choose Save As > Document.

The Save Document As dialog box appears.

2 Do either or both of the following:

■ Type a new name for the file.

■ Choose a new location at which to save the file.

3 Click Save.

Opening a saved document, presentation, or whiteboard

If you saved a document, presentation, or whiteboard that appeared in the content 
viewer during a training session, you can do either of the following:

■ Open file in the content viewer during another training session for sharing. If the 
presenter has assigned the Share documents privilege, you can open a saved file 
during a training session.

■ Open the file at any time on your computer's desktop. If you open a saved file 
on your desktop, it appears in the WebEx Document Manager, a standalone, or 
“offline,” version of the content viewer. 

A saved document, presentation, or whiteboard is in the saved Universal 
Communications Format (UCF) and has a .ucf extension.

To open a saved document, presentation, or whiteboard file in the content viewer:

1 On the File menu, choose Open > Document.
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The Open Document dialog box appears.

2 Select the document, presentation, or whiteboard file that you want to open.

3 Click Open.

To open a saved document, presentation, or whiteboard on your computer's 
desktop:

Double-click the saved file.

The document, presentation, or whiteboard opens in the WebEx Document 
Viewer.

Printing presentations, documents, or whiteboards

If the presenter has granted you the Print document privilege, you can print any 
shared presentations, documents, or whiteboards that appear in your content 
viewer. A printed copy of shared content includes all annotations and pointers that 
you or other attendees added to it.

To print shared content:

1 In the content viewer, select the tab for the document, presentation, or 
whiteboard that you want to print.

2 On the File menu, choose Print > Document.

3 Select the printing options that you want to use, and then print the document.

Note When printing shared content in the content viewer, Meeting Manager 
resizes it to fit on the printed page. However, for whiteboards, the Meeting Manager 
prints only the content that lies within the dashed lines on the whiteboard. 
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7
Working with Shared Software

About interacting with shared software
If a presenter shares one of the following types of software during a training session, 
it appears in a sharing window that automatically opens on your screen:

■ Application

■ Computer desktop

■ Web browser

■ Remote computer

The following is an example of a sharing window in which the presenter is sharing 
a Microsoft Word document:

If you want to... See...

learn about tasks you can perform while the 
presenter is sharing software

About interacting with shared software on 
page 71

control and resize your view of shared 
software

Controlling your view of shared software on 
page 72

control software that the presenter is sharing Requesting remote control of shared software 
on page 73

annotate software that the presenter is 
sharing

Annotating shared software on page 74

switch between the sharing window and the 
main Session window

Switching between the sharing window and 
the Session window on page 77

Close the sharing window to stop viewing the 
shared software

Closing a sharing window on page 77
71



Chapter 7: Working with Shared Software
While viewing shared software, you can: 

■ Control your view of the shared software, such as switching between a 
full-screen view and a standard window or scaling the view to fit on your screen. 
For details, Controlling your view of shared software on page 72.

■ Request the presenter to grant remote control to you. For details, see Requesting 
remote control of shared software on page 73

■ Request the presenter to grant annotation control to you. For details, see 
Requesting annotation control of shared software on page 74.

■ Switch between viewing the sharing window and the main Session window. For 
details, see Switching between the sharing window and the Session window on 
page 77.

■ Close a sharing window to stop viewing shared software, and return to the 
sharing window at any time. For details, see Closing a sharing window on page 77.

Controlling your view of shared software
When viewing or remotely controlling shared software, you can specify the 
following options, which determine how a shared software appears on your screen:

■ Display the shared software in a full-screen view or a standard window. A 
full-screen view of a shared application or desktop fits your entire screen and 
does not include a title bar or scroll bars.

■ Scale, or resize, a shared desktop or application to fit the full-screen view or 
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standard window in which it appears.

To control your view of shared software:

1 Do either of the following:

■ On the floating icon tray, click the Select Panel button.

■ In the title bar of the sharing window, click the Sharing button.

2 On the menu that appears, choose View, then choose an option for viewing the 
shared software. 

Tip To quickly switch between a standard window and a full-screen view of shared 
software, double-click the shared software.

Requesting remote control of shared software
If a presenter is sharing the following types of shared software, you can request the 
presenter to grant remote control to you:

■ Application

■ Desktop

■ Web browser

Once you assume remote control of shared software, you can interact with it 
completely.
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To request remote control of shared software:

1 In the sharing window, click the Sharing button.

2 On the menu that appears, choose Request Remote Control. 

A remote-control request message appears on the presenter's screen.

Tip While remotely controlling shared software, you can request the presenter to 
allow you to annotate it. For details, see “Requesting annotation control of shared 
software” on page 74.

Annotating shared software

Requesting annotation control of shared software

If a presenter is sharing the following types of shared software, you can request the 
presenter to grant annotation control to you:

■ Application

■ Desktop

■ Web browser

Once you have annotation control, you can:

■ Make annotations by highlighting areas on the software, drawing lines and 
shapes, typing text, and using pointers.

■ Clear annotations at any time.

■ Change the color that you are using to make annotations.

■ Save an image of your annotations on the shared software.

To request annotation control of shared software:

1 In the title bar of the sharing window, click the Sharing button.

If you want to... See...

ask the presenter to let you annotate the 
software that he or she is sharing

Requesting annotation control of shared 
software on page 74

learn how to use the annotation tools in the 
Annotation panel

Using annotation tools on page 75

stop annotating the shared software and 
regain your normal mouse pointer

Stopping annotations on page 76
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2 On the menu that appears, choose Request Annotation. 

A request message appears on the presenter's screen.

Once the presenter grants annotation control to you, the Annotation panel 
appears:

Your mouse pointer becomes a highlighter tool. 

3 To make annotations, drag your mouse.

4 Optional: Choose another annotation tool. For details, see Using annotation 
tools on page 75.

Note If you are remotely controlling shared software, the presenter must reassume 
control, and then turn on annotation mode. You and the presenter can then 
annotate the shared software simultaneously.

Using annotation tools

If, while sharing software, the presenter grants annotation control to you, you can 
use the Annotation panel that appears to make annotations. The Annotation panel 
provides a variety of tools for annotating a shared desktop or application.

Pointer tool

Text tool

Line tool

Rectangle tool Annotation Color

EraserHighlighter tool Screen Capture
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Stopping annotations

If the presenter has granted annotation control to you, you can stop making 
annotations at any time.

To stop making annotations:

1 In the sharing window, click the Sharing button.

2 On the menu that appears, choose Give up Annotation.

Tool Description

Pointer Lets you point out text and graphics on shared software. The pointer 
displays an arrow with your name and annotation color. To display the 
laser pointer, which lets you point out text and graphics on shared 
content using a red “laser beam,” click the downward-pointing arrow. 
Clicking this button again turns off the pointer tool.

Text Lets you type text on shared software. Participants can view the text 
once you finish typing it and click your mouse outside the text box.

Line Lets you draw lines and arrows on shared software. For more options, 
click the downward-pointing arrow. Clicking this button again closes 
the Line tool.

Rectangle Lets you draw shapes, such as rectangles and ellipses on shared 
software. For more options, click the downward-pointing arrow. 
Clicking this button again closes the Rectangle tool.

Highlighter Lets you highlight text and other elements in shared software. For 
more options, click the downward-pointing arrow. Clicking this button 
again closes the Highlighter tool

Annotation Color Displays the Annotation Color palette, on which you can select a color 
to annotate shared software. Clicking this button again closes the 
Annotation Color palette. 

Note The annotation color that you choose does not affect the color 
for your pointer.

Eraser Erases text and annotations or clears pointers on shared content. To 
erase a single annotation, click it in the viewer. For more options, click 
the downward-pointing arrow. Clicking this button again turns off the 
eraser tool.

Screen Capture Saves an image of your entire desktop, including annotations and 
pointers, to a file. You can save the image in one of the following 
formats:

■ BMP

■ GIF

■ JPEG
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Switching between the sharing window and the 
Session window

While a presenter is sharing software, you can return to the Session window at any 
time. The sharing window remains open on your computer, so you can return to 
viewing the shared software at any time.

To return to the Session window while the presenter is sharing software:

On the floating icon tray, click the Return to Session window icon.

The Session window then appears.

To return to a sharing window:

Do either of the following:

■ In the Application Share dialog box, which appears in the Session window, click 
Return.

■ In the Session window, on the Sharing menu, click the appropriate sharing 
option:

Application

Desktop

Web Browser

Remote Computer

Closing a sharing window
While viewing or remotely controlling shared software, you can close the sharing 
window in which the software appears at any time. Closing a sharing window 
returns you to the Session window. If you close a sharing window, you can reopen 
it at any time.
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To close a sharing window:

1 In the sharing window, click the Sharing button.

2 On the menu that appears, choose the appropriate option:

■ Exit Application Sharing

■ Exit Web Browser Sharing

■ Exit Desktop Sharing

■ Exit Remote Application Sharing

■ Exit Remote Desktop Sharing

The sharing window closes. The Session window then automatically opens.

To return to the sharing window at any time:

In the Session window, on the Sharing menu, click the appropriate sharing option:

■ Application

■ Desktop

■ Web Browser

■ Remote Computer
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Downloading Files During a 
Training Session

If a presenter publishes files during a training session, the File Transfer dialog box 
automatically appears in your Session window. You can then download the 
published files to your computer or a local server.

To download files during a training session:

1 In the File Transfer window, select the file that you want to download.

2 Click Download.

The Save As dialog box appears.

3 Choose a location at which to save the file.

4 Click Save.

The file downloads to your selected location.

5 If applicable, download additional files.
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6 Once you finish downloading files, in the title bar of the File Transfer window, 
click the Close button.

Note To reopen the File Transfer window at any time, from the File menu, choose 
Transfer. This option is available only if the presenter is currently publishing files.
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Using Chat

About using chat
You can send and receive chat messages to and from training session participants. 
All chat messages that you send or receive appear on the Chat panel in the Session 
window.

Chat is useful if you want to:

■ Communicate with other participants during a training session that does not 
include a voice conference

■ Send a private message to another participant

■ Send brief information to all participants or a specific group of participants

■ Ask a question but do not want to interrupt the presenter

Note During a training session, the presenter can specify chat privileges for all 
participants. These privileges determine to whom participants can send chat 
messages.

If you want to ... See ...

get an overview of using chat About using chat on page 81

send chat messages Sending chat messages on page 82

assign sounds to incoming messages Assigning sounds to incoming chat messages 
on page 83

print chat messages Printing chat messages on page 84

save chat messages Saving chat messages on page 84

open a chat file during a training session Opening a chat file during a training session 
on page 86
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Sending chat messages
Depending on the chat privileges that the training session host has granted to 
participants, you can send a chat message to:

■ Only the host

■ Only the presenter

■ Only the host and the presenter

■ only the host, presenter, and panelists

■ All attendees at once, not including the training session host, the panelists, and 
the presenter

■ All participants at once, including all attendees, the training session host, the 
panelists, and the presenter

■ Another participant, privately

To send a chat message:

1 In the Session window, open the Chat panel.

2 Type a message in the chat box.

3 In the Send to drop-down list, select the recipients of the message.

4 Click Send.

The recipients receive the chat message on their Chat panels. The following 
figure shows an example.

chat box
82



Chapter 9: Using Chat
Note If you join a training session in progress, you can see only the chat 
messages that attendees send after you join the training session.

Assigning sounds to incoming chat messages
You can assign a sound to play when you receive a chat message. Specifically, you 
choose to play a sound for one of the following occasions:

■ If you are not viewing the Chat panel

■ For only the first chat message that you receive in a thread

■ Whenever you receive a chat message

To assign sounds to incoming chat messages:

1 Do either of the following:

■ On the Chat panel, right-click the Chat title bar, and then choose Sound 
Alerts.

■ In the Session window, on the Edit menu, choose Personal Preferences.

The Personal Preferences dialog box appears.

2 Click Communications under Category.

3 Select Receiving a chat message.

4 In the drop-down list, choose the occasion for which you want to assign a sound.

5 Select a sound to play. You can do either of the following:

■ Select a sound in the Play sound drop-down list.
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This list contains the names of all sound files that reside at the default loca-
tion on your computer.

■ Click Browse, and then select a sound file that resides in another folder.

6 Optional. To play the currently selected sound, click the button.

7 Click OK.

Note

■ The default location on your computer for sound files is standard, and is based 
on your computer's operating system. On a computer running Windows, the 
default location is the Media folder.

■ You can copy other sound files of the appropriate types to the default location, 
or any other directory, to make them available in the Personal Preferences dialog 
box.

■ On a computer running Windows, you can play any .wav file.

Printing chat messages
You can print all the chat messages that appear on the Chat panel.

To print chat messages:

1 In the Session window, on the File menu, choose Print > Chat.

A print dialog box appears.

2 Optional. Specify printer options.

3 Print.

Note If no chat messages appear on your Chat panel, this Chat option is 
unavailable.

Saving chat messages

If you want to ... See ...

get an overview of saving chat messages About saving chat messages on page 85
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About saving chat messages

You can save chat messages that appear on the Chat panel to a .txt file. You can 
then reopen the file for use in any training session or view the file's content outside 
a training session by opening the file in a text editor.

Once you save chat messages to a file, you can save changes to the messages or save 
a copy of them to another file.

Saving chat messages

You can save chat messages you have sent or received to a new chat file. Training 
Manager also automatically saves chat messages every two minutes to the WebEx 
folder in the My Documents folder on your computer.

To save new chat messages:

1 In the Session window, on the File menu, choose Save> Chat.

The Save Chat As dialog box appears.

2 Choose a location at which you want to save the file.

3 Type a name for the file.

By default, the name of the previous chat file you saved displays. You can save all 
chat messages in your current training session to this existing file, or save them 
to a new file.

4 Click Save.

Training Manager saves the chat messages in a .txt file at the location you 
selected.

Note If no chat messages appear on your Chat panel, this option is unavailable.

Saving changes to a chat file

If you make changes to the messages on your Chat panel, you can save them to an 
existing chat file.

save new chat messages Saving chat messages on page 85

save changes to a chat file Saving changes to a chat file on page 85

save a copy of a chat file Creating a copy of previously saved chat 
messages on page 86

If you want to ... See ...
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To save changes to a chat file:

In the Session window, on the File menu, choose Save> Chat.

Training Manager saves the changes to the existing chat file.

Note If no chat messages appear on your Chat panel, this option is unavailable.

Creating a copy of previously saved chat messages

If you have saved chat messages and want to create another copy of the messages, 
you can do so by saving the chat messages to a chat file with a different name.

To create a copy of chat messages that have been previously saved:

1 In the Session window, on the File menu, choose Save As > Chat.

The Save Chat As dialog box appears.

2 Do either or both of the following:

■ Type a new name for the file.

■ Choose a new location at which you want to save the file.

3 Click Save.

Training Manager saves the file at the location you chose. Its file name has a .txt 
extension.

Opening a chat file during a training session
If you saved chat messages to a file, you can display those chat messages on your 
Chat panel by opening the file.

To open a chat file:

1 In the Session window, on the File menu, choose Open > Chat.

The Open Chat dialog box appears.

2 Select the chat file that you want to open.

Tip The names of chat files have a .txt extension.

3 Click Open.

The chat messages appear on the Chat panel.

If there are already chat messages in your chat viewer, Training Manager 
appends the messages from the chat file to the existing messages.
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Using Hands-on Lab

About Hands-on Lab
Hands-on Lab sessions allow instructors to prepare lessons or exercises that 
students can complete on remote computers on which training software is installed. 
Students can use these remote computers during a training session for hands-on 
learning and practice. Because instructors can control Hands-on Lab sessions, they 
can maintain an optimized lab environment that is effective, familiar, and 
consistent.

If you want to... See...

get an overview of Hands-on Lab About Hands-on Lab on page 89

connect to a reserved computer Connecting to a reserved computer on 
page 90

use the Hands-on Lab Session Manager Using the Hands-on Lab Manager on page 93

use Hands-on Lab chat Using Hands-on Lab chat on page 94

ask for help in Hands-on Lab Asking for help in Hands-on Lab on page 95

transfer files in a Hands-on Lab session Transferring files in a Hands-on Lab session 
on page 95

pass control of the Hands-on Lab computer Passing control of the Hands-on Lab 
computer on page 96

leave a Hands-on Lab session Leaving a Hands-on Lab session on page 97

disconnect from computers Disconnecting from computers on page 97
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To set up a Hands-on Lab session, the host schedules the lab and reserves the 
computers for the presenter. Then the host starts the Hands-on Lab within the 
training session. The presenter assigns computers to participants, connects the 
computers with a mouse click, and then each participant can use the virtual 
computer at his or her own remote location. Participants can also

■ connect to a reserved computer

■ chat with other Hands-on Lab participants

■ ask for help during a Hands-on Lab session

■ transfer files in a Hands-on Lab session

■ pass control of a Hands-on Lab computer

■ disconnect from a Hands-on Lab computer

Connecting to a reserved computer
Participants in a Hands-on Lab session can connect to an unassigned computer or 
a preassigned computer depending on which option the presenter chose when 
starting the session.

Connecting to unassigned computers

If the presenter allowed participants to choose their own remote computer, they can 
connect to any reserved computer in the session. 

To connect to a computer, do one of the following:

■ On the Lab menu, point to Connect to Computer. Then select the remote 
computer to which you want to connect. 

■ On the Hands-on Lab panel, select the computer to which you want to connect. 
Click Connect.

You are connected to the remote computer. The Hands-on Lab Manager 
window is available from the floating icon tray on your desktop. You can also 

control the remote computer using the Sharing menu. 

Connecting to preassigned computers

If the presenter chose to manually assign computers to Hands-on Lab participants, 
the Hands-on Lab Session connect message appears on the participant’s desktop.
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To connect to the remote computer, click Yes.

You are now connected to the remote computer. The Hands-on Lab Manager 
window is available from the floating icon tray on your desktop. You can also 

control the remote computer using the Sharing menu. 

Using Integrated VoIP or teleconferencing in Hands-on Lab 
sessions

You can communicate with Hands-on Lab participants using Integrated VoIP or 
teleconferencing. If teleconferencing is set up in the main training session, when 
you start a Hands-on Lab session, the call-in or call-back teleconference 
automatically starts for the Hands-on Lab session. All the teleconferencing options 
or Integrated VoIP options that the host set up in the main session apply to the 
Hands-on Lab sessions.

Note

■ Participants in a Hands-on Lab session cannot join a Hands-on Lab session 
teleconference until the Hands-on Lab session presenter joins the 
teleconference. 

■ When a participant who has already joined the main teleconference session 
(WebEx integrated call-in or call-back teleconference only) joins a Hands-on 
Lab session, he or she is switched from the main session teleconference to the 
Hands-on Lab session teleconference automatically. Participants cannot join a 
teleconference in the main session while connected to a Hands-on Lab session 
teleconference. 

■ If teleconferencing is not available or has not been started for the main session 
before the Hands-on Lab session is started, teleconferencing for Hands-on Lab 
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sessions is disabled also. 

■ When a participant who is in the Hands-on Lab session teleconference leaves a 
Hands-on Lab session, he or she disconnects from the Hands-on Lab session 
teleconference automatically. The participant returns to the main session and 
can join the main teleconference by selecting Join Teleconference on the 
Communicate menu.

Starting an Integrated VoIP conference during a Hands-on Lab 
session

To use an Integrated VoIP conference, your computer must meet the system 
requirements for Integrated VoIP. For details, see System requirements for Integrated 
VoIP on page 36.

When you start an Integrated VoIP conference in a Hands-on Lab session, all the 
Integrated VoIP options that the host set up in the main session apply to the 
Hands-on Lab sessions.

To start an Integrated VoIP conference in a Hands-on Lab session:

1 In the Hands-on Lab Session window, on the Communicate menu, point to 
Integrated VoIP, and then choose Start Conference.

2 Optional. To use the Volume dialog box to adjust the volume of your speakers 
or microphone or to mute or unmute your speakers or microphone, point to 
Integrated VoIP, and then choose Volume.

3 Optional. To use the Audio Setup Wizard to set up audio options, choose Audio 
Setup Wizard on the Communicate menu. 

The following occur:

■ The Volume dialog box appears, on which you can adjust the speaker or 
microphone volume.

■ A microphone symbol appears to the left of your name in the participant list on 
the Hands-on Lab Sessions Manager panel.

Note The microphone symbol flashes to indicate which participant is speaking 
during the Hands-on Lab session.

■ The Join Integrated VoIP Session message box automatically appears in the 
Session window for each participant in the Hands-on Lab session whose 
computer has a supported sound card. Participants can then choose to 
participate in the Integrated VoIP conference.
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Ending an Integrated VoIP conference in a Hands-on Lab session

You can end an Integrated VoIP conference at any time during a Hands-on Lab 
session.

To end an Integrated VoIP conference:

In the Hands-on Lab Session Manager window, on the Communicate menu, point 
to Integrated VoIP, and then choose End Conference.

Integrated VoIP is no longer available to participants during the Hands-on Lab 
session.

For details on rejoining the main session Integrated VoIP conference, see Starting 
an Integrated VoIP conference during a Hands-on Lab session on page 92.

Starting a teleconference during a Hands-on Lab session

If you are in the main session teleconference when a Hands-on Lab session starts, a 
dialog box appears, asking you whether to switch to a separate Hands-on Lab 
teleconference.

■ If you select Yes, you are switched to a Hands-on Lab session teleconference.

■ If you select No, you will not join the Hands-on Lab session teleconference at 
this time. However, you can join later by selecting Switch to Hands-on Lab 
Teleconference from the Communicate menu.

Note There must be more than one participant connected to the Hands-on Lab 
computer to start the Hands-on Lab teleconference. Otherwise, this prompt will 
not appear.

Ending a teleconference in a Hands-on Lab session

When you leave a Hands-on Lab session teleconference, you will rejoin the main 
teleconference automatically.

Using the Hands-on Lab Manager
Once the presenter starts the Hands-on Lab session and participants have 
connected to the computers, the Hands-on Lab Session Manager is available on 
your desktop. On the floating icon tray, click Hands-on Lab Panel.

Hands-on Lab Panel
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The Hands-on Lab Manager lists the participants in the lab to which they are 
connected. In the Hands-on Lab Manager, participants can transfer files to and 
from their computers and ask for help. When you are in a Hands-on Lab session, 
you can use the Hands-on Lab computer directly from your own computer just as 
if you are sitting at the Hands-on Lab computer.

A green computer icon next to your name indicates that you are connected to 
the Hands-on Lab computer. 

Using Hands-on Lab chat
You can send and receive chat messages to and from other Hands-on Lab 
participants. All chat messages that you either send or receive appear in your Chat 
viewer. Hands-on Lab chat works the same way that chat works in the training 
session, except in Hands-on Lab, your chat message sends to all Hands-on Lab 
participants. 

To use Hands-on Lab chat:

1 On the floating icon tray on your desktop, click Chat Panel.

2 Type a message in the Chat box.

Chat Panel
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3 Click Send.

All Hands-on Lab participants receive the chat message in their Chat message 
boxes.

Asking for help in Hands-on Lab
You can ask for help at any time during the Hands-on Lab session. 

To ask for help:

On the Hands-on Lab Manager window, click the Raise Hand button. 

The Raise Hand indicator  appears next to your name on the Hands-on Lab 
Manager window, alerting the presenter to your request for help. 

Transferring files in a Hands-on Lab session
During a Hands-on Lab session, you can transfer files to and from the Hands-on 
Lab computer. You can transfer files that reside at any location on either the 
Hands-on Lab computer or on your local computer.

Transferring files works the same way as it does within the training session. 

To transfer files to or from your computer, do one of the following:

■ On the Hands-on Lab Manager window, click the Transfer File button. 

■ On the Sharing menu , click Transfer File. 

The Hands-on Lab Transfer File window appears. 
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In the pane on the left, the file directory for your local computer is labeled Local 
Computer. The file directory for the Hands-on Lab remote computer is labeled 
Remote Computer.

1 In the pane on the left, expand a directory to display the folder in which you 
want to transfer a file.

2 In the pane on the right, expand the other directory until the file that you want 
to transfer appears.

3 Drag the file to the folder in which you want to transfer it into the pane on the 
left.

Passing control of the Hands-on Lab computer
During a Hands-on Lab session, you can pass control of the computer to anyone 
connected to the same computer.

To pass control of the computer:

1 On the Hands-on Lab Manager window, select the name of the participant to 
whom you want to transfer control. The participant must be connected to the 
computer at the time you transfer control.

 A green icon next to a participant’s name indicates that the participant 
is connected to the computer. 

 A gray icon next to a participant’s name indicates that the participant is 
disconnected from the computer.

2 In the Hands-on Lab Manager window, click the Pass Control icon.  
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The Pass Control icon  appears next to the participant who has control of the 
Hands-on Lab computer.

Leaving a Hands-on Lab session
You can leave a Hands-on Lab session and return anytime during the session. 

To leave a Hands-on Lab session:

On the Sharing menu , click Leave Hands-on Lab.

To reconnect to the Hands-on Lab computer, see Connecting to a reserved computer 
on page 90.

Disconnecting from computers
Once you have finished your Hands-on Lab sessions, you can disconnect from your 
remote computer.

To disconnect from the remote computer:

1 On the floating icon tray, click Return to Main Window.

The Return to Hands-on Lab Computer dialog box appears.

2 Click Disconnect from Computer.

Return to Main Menu
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Answering Polls

Filling out a poll questionnaire
Once the presenter opens a poll during a training session, the poll questionnaire 
appears on your Polling panel.

To fill out a poll questionnaire:

1 Select the option buttons or check boxes for each question.

2 If the questionnaire includes text questions, type your answers in the boxes.

3 When you finish answering the questionnaire, click Submit.

If the presenter shares the results of the poll, you can view them on your Polling 
panel. For details, see Viewing poll results on page 99.

Viewing poll results
After the presenter closes a poll, the presenter can share the results with training 
session attendees. Shared results appear on your Polling panel.

The following figure shows an example of shared poll results:

If you want to... See...

fill out a poll questionnaire during a training 
session

Filling out a poll questionnaire on page 99

learn about viewing shared poll results Viewing poll results on page 99
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The Results column indicates the percentage of attendees who chose each answer. 
The Bar Graph column provides a graphic representation of each percentage in the 
Results column. The Questions column shows your answers.
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Participating in a 
Question-and-Answer Session

About Question-and-Answer sessions
Question-and-Answer (Q & A) sessions during a training session allow you to ask 
questions and receive answers using your Q & A panel, in a more formal way than 
Chat.

Your Q & A panel automatically groups questions and answers into the following 
two tabs, which make it easy for you to check whether your questions have been 
answered:

All—all questions and answers in a Q & A session during the training session

My Q & A—the questions you sent and the answers to your questions

Note The host has to turn on the Q & A function in the training session before you 
can use the Q & A panel.

If you want to... See...

get an overview of asking questions in a 
Question-and-Answer session

About Question-and-Answer sessions on 
page 101

learn how to open or close a tab on your Q & 
A panel

Working with the tabs on your Q & A panel on 
page 102

send a question in a Q & A session Asking a question in a Q & A session on 
page 102

check whether your questions have been 
answered or not

Checking the status of your questions on 
page 103
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Working with the tabs on your Q & A panel
Your Q & A panel provides two views of the question-and-answer queue: the All 
and My Q & A tabs. The All tab stays open all the time on your Q & A panel. 

The My Q & A tab displays as soon as you send your first question using Q & A. You 
can close the My Q & A tab at any time.

To open the My Q & A tab:

Right-click the All tab, and then choose Open Tab > My Q & A.

To close the My Q & A tab:

Right-click the My Q & A tab, and then choose Close Tab.

Note Closing the My Q & A tab does not cause you to lose the questions and 
answers on the tab. You can re-open it at any time.

Asking a question in a Q & A session
During a training session, you can send your questions to all or specific panelists in 
a Q & A session.

To ask a question in a Q & A session:

1 Open your Q & A panel by clicking Panels and then choosing Q & A in the 
drop-down list. The following figure shows an example.

The Q & A panel appears.

2 Type your question in the text box.

3 Optional. To edit your question, highlight the text you want to edit, and then 
right-click.

You can use the editing commands on the right-click menu.

4 In the Ask drop-down list, select the recipient, and then click Send.

Click Panels to open the 
Q & A panel.
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Checking the status of your questions
The auto-grouping of questions and answers and visual cues on attendees’ Q & A 
panels make it easy for you to check whether a panelist has responded to your 
question. For details, see My Q & A tab on page 103 and Answering indicator on 
page 104.

My Q & A tab

Your Q & A panel provides two views of the question-and-answer queue: the All 
and My Q & A tabs. Always check the My Q & A tab to quickly find out whether 
your question has been answered. This tab displays a list of the questions you sent 
and the answers, whether public or private, to those questions.

The following figure shows an example of your Q & A panel, the tabs, and a visual 
cue.

Select: To send the question to:

panelist’s name in the 
list

a particular panelist

Host training session host only

Presenter presenter only

Host & Presenter host and presenter only

All Panelists all panelists, including the training session host and presenter

The My Q & A tab displays the questions that you sent 
and the answers to those questions.

If a panelist answers your question privately, the text 
private appears next to the answer. No attendee can see 
this private answer, except yourself.
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Answering indicator

When a panelist is typing an answer to a question, an in-progress indicator displays 
under that question. The following figure shows an example.
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Providing Feedback

About providing feedback
During a training session, the host or presenter can pose a question—either verbally 
during a teleconference or Integrated VoIP conference, or in a chat message—and 
receive your instant feedback.

As an attendee, you can:

■ click the Raise Hand icon if the presenter asks for a show of hands in response 
to a question, or if you have a question

■ choose the Yes or No icon in response to a question

■ choose Go Fasteror Go Slower icon to indicate that the presenter’s pacing is too 
slow or too fast

■ express yourself using emoticons

Providing feedback
The following table shows the types of feedback you can provide during a training 
session:

If you want to ... See ...

get an overview of feedback About providing feedback on page 105

provide feedback Providing feedback on page 105

using emoticons in feedback Using emoticons in feedback on page 106

click if the presenter asks for a show of hands in response to 
a question or if you have a question
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To provide feedback:

1 You can provide feedback by clicking one of the icons on the Participants panel. 

2 Verify that the response indicator that appears to the right of your name reflects 
your feedback.

Click the icon again if you wish to remove it from the Participants panel.

Using emoticons in feedback
You can use emoticons to express your feelings or status from the Participants 
panel by using the emoticons drop-down menu.

To use emoticons:

1 Click the drop-down menu of the Emoticons icon on the Participants panel.

The Emoticons palette appears.

click to indicate yes in response to a question

click to indicate no in response to a question

click to indicate to the presenter to slow down his or her 
pacing

click to indicate to the presenter to speed up his or her pacing

click the drop-down menu to open the Emoticons palette on 
which you can use an emoticon to express yourself

click the icon to display a running tally of responses

click the icon to clear all feedback
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2 Select one of the following emoticons from the palette.

The corresponding emoticon appears to the right of your name on the 
Participants panel.

applaud the presenter

approve the presenter

indicate that you are taking a rest or break or would like to take a 
break

indicate that you are not available

indicate that you have an idea

indicate that you are confused

indicate that you are sleepy or bored

show astonishment or surprise

indicate happiness

laugh out loud

show that you are curious or skeptical

tell presenter to watch out or to be careful
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Taking a Test

About taking a test
The host or presenter of a training session that you are attending can conduct tests 
before, during, or after the session, or during a recorded session in a Presentation 
Studio presentation, to test your knowledge of the training content or seek 
feedback.

A host may request you to take one of the following types of tests:

■ Pre- or post-session tests—A test starts and ends at the specified times and dates 
outside a training session. Email messages you receive from the host contain 
information about how to access these tests.

■ In-session tests—The host starts a test during a training session. Your training 
service does not send email messages about these tests on behalf of the host. You 
can obtain test information by contacting the host.

■ Recorded session tests (only in Presentation Studio presentations)—A test can 

If you want to ... See ...

get an overview of taking a test About taking a test on page 109

know what information is required before you 
take a test

Before you take a test on page 110

obtain test information before taking a test Obtaining test information on page 111

take a pre- or post-session test Taking a pre- or post-session test on 
page 113

take an in-session test Taking an in-session test on page 116

take a recorded session test in a Presentation 
Studio presentation

Taking a recorded session test in a 
Presentation Studio presentation on page 118

know how to answer questions during a test Answering questions on page 119

view your test results Viewing test results on page 121
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be taken once, at any time during the recorded session.

You take tests and submit your answers on the Web. Once scoring is completed, you 
can view test results from the Session Information page on your Training Center 
Web site, on the Test Submitted page for a recorded session, or from the host’s 
email message that contains your grade report.

Before you take a test

Required information before you take a test

To take a test, you must register for the training session with which the test is 
associated. For more information about registering for a training session, see 
Registering for a Training Session on page 22.

Once the host approves your registration, you receive a confirmation email message 
that contains a unique registration ID, the session password, if any, and a link that 
you can click to open the Session Information page, from which you can take a pre- 
or post-session test. For details about the Session Information page, see About the 
Session Information page on page 110.

At least one day prior to the starting date of a pre- or post-session test, you may also 
receive an invitation email message to take the test, if the host specifies to send such 
email messages to attendees whose registration has been approved. The message 
contains detailed information about a test and a link you can click to take the test.

For recorded session tests, your email address is used to identify you rather than a 
registration ID. If registration is not required for the recorded session, you will enter 
your name and email address before taking the test.

About the Session Information page

To access the Session Information page for a training session, you can go to the 
training calendar on your Training Center Web site and then click the link for the 
session topic.

This page displays detailed information, such as the session descriptions, session 
password, the host’s and presenter’s information, test information, course 
materials, and so on. From this page, you can take pre- or post-session tests, view 
information about these tests, and view your test results.

If you want to ... See ...

know what information is required before you 
can take a test

Required information before you take a test on 
page 110
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Obtaining test information

About obtaining test information

Note Test information is not available in advance for recorded session tests.

Before obtaining information about a pre- or post-session test, you must have 
registered and received a registration ID for the training session with which the test 
is associated.

You can obtain information about a pre- or post-session test from any of the 
following:

■ A registration confirmation email message

■ The training calendar on your Training Center Web site

■ An invitation email message to take a test, if you received the email from the host

To obtain information about an in-session test prior to joining the training session, 
contact your training session host.

Obtaining test information from a registration confirmation 
email message

Once the training session host approves your registration request, you receive a 
registration confirmation email message that contains a link you can click to obtain 
test information.

To obtain test information from a registration confirmation email message:

1 Open the registration confirmation email, and then click the appropriate link.

2 If the host requires a session password, type the session password in the 
Password text box, and then click View Info.

The Session Information page, with full details, appears. The Tests section 
displays all pre- or post-session tests associated with this training session.

If you want to ... See ..

get an overview of obtaining test information About obtaining test information on page 111

obtain test information from a registration 
confirmation email message you receive from 
the host

Obtaining test information from a registration 
confirmation email message on page 111

obtain test information from the training 
calendar on your Training Center Web site

Obtaining test information from the training 
calendar on page 112

obtain test information from an invitation email 
message to take a test

Obtaining test information from an invitation 
email message to take a test on page 113
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3 In the Tests section, locate the test you want to view, and then do either of the 
following:

■ In the Action column, click View Info.

■ In the Title column, click the test title.

The Log In page appears.

4 Do one of the following:

■ If you have an attendee account, log in using your user name and password.

The View Test Info page appears.

For details, see About attendee accounts on page 113.

■ If you do not have an attendee account, select Continue without signing up, 
and then click Continue.

5 If you select Continue without signing up, type your registration ID and the 
session password, if required, and then click OK.

The View Test Info page appears.

Obtaining test information from the training calendar

You can obtain test information from the training calendar on your Training 
Center Web site once the training session host approves your registration.

To obtain test information from the training calendar:

1 On your Training Center Web site, expand Attend a Session, and then click Live 
Sessions.

2 Locate the training session with which the test is associated, and then click the 
link for the session topic.

3 If the host requires a session password, type the session password in the 
Password text box, and then click View Info.

The Session Information page, with full details, appears. The Tests section 
displays all pre- or post-session tests associated with this training session.

4 In the Tests section, locate the test you want to view, and then do either of the 
following:

■ In the Action column, click View Info.

■ In the Title column, click the test title.

The Log In page appears.

5 Do one of the following:

■ If you have an attendee account, log in using your user name and password.

The View Test Info page appears.
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For details, see About attendee accounts on page 113.

■ If you do not have an attendee account, select Continue without signing up, 
and then click Continue.

6 If you select Continue without signing up, type your registration ID and the 
session password, if required, and then click OK.

The View Test Info page appears.

Obtaining test information from an invitation email message to 
take a test

You may receive an invitation email message to take a test if the training session 
host sends such email messages to attendees whose registration has been approved.

To obtain test information from an invitation email message to take a test:

Open the invitation email message, and then click the appropriate link.

The View Test Info page appears.

About attendee accounts

An attendee account stores a user’s personal information and session information 
associated with that user, such as a registration number.

A training session host may require that you have an attendee account to join a 
training session, view test information, or take a test. If you log in using an attendee 
account, you do not need to provide personal information or a registration number 
for those tasks.

For information about obtaining an attendee account, ask your training session 
host.

Taking a pre- or post-session test

If you want to ... See ...

get an overview of taking a pre- or 
post-session test

About taking a pre- or post-session test on 
page 114

take a test from a registration confirmation 
email message you receive from the host

Taking a test from a registration confirmation 
email message on page 114

take a test from the training calendar on your 
Training Center Web site

Taking a test from the training calendar on 
page 115

take a test from an invitation email message to 
take a test

Taking a test from an invitation email message 
on page 116

leave and return to a test Leaving and returning to a test on page 116
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About taking a pre- or post-session test

A pre- or post-session test starts and ends at the times specified by your training 
session host. If the host also specifies a time limit, you must finish the test within 
the time limit during the scheduled time frame.

Before taking a test, you must have registered and received a registration ID for the 
training session with which the test is associated. Once you register for a training 
session, you can take all the tests associated with that session.

You can take a pre- or post-session test from any of the following:

■ A registration confirmation email message

■ The training calendar on your Training Center Web site

■ An invitation email message to take a test, if you received the email from the host

Taking a test from a registration confirmation email message

Once the host approves your registration, you receive a confirmation email message 
that contains a link you can click to open the Session Information page, from which 
you can take a test.

To take a test from a registration confirmation email message:

1 Open the email, and then click the appropriate link.

2 If the host requires a session password, type the session password in the 
Password text box, and then click View Info.

The Session Information page, with full details, appears. The Tests section 
displays all pre- or post-session tests associated with this training session.

3 In the Tests section, do either of the following:

■ In the Action column, click Take Test.

■ In the Title column, click the test title.

The Log In page appears.

4 Do one of the following:

■ If you have an attendee account, log in using your user name and password.

The Take Test page appears.

For details, see About attendee accounts on page 113.

■ If you do not have an attendee account, select Continue without signing up, 
and then click Continue.

5 If you select Continue without signing up, type your registration ID and the 
session password, if required, and then click OK.

The Take Test page appears.
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6 Click Take Test.

7 Answer the questions.

8 When finished, click Submit Test.

For more information about answering questions, see Answering questions on 
page 119.

Taking a test from the training calendar

You can take a test from the training calendar on your Training Center Web site.

To take a test from the training calendar:

1 On your Training Center Web site, expand Attend a Session, and then click Live 
Sessions.

2 Locate the training session with which the test is associated, and then click the 
link for the session topic.

3 If the host requires a session password, type the session password in the 
Password text box, and then click View Info.

The Session Information page, with full details, appears. The Tests section 
displays all pre- or post-session tests associated with this training session.

4 In the Tests section, locate the test that you want to take, and then click Take Test 
in the Action column.

The Log In page appears.

5 Do one of the following:

■ If you have an attendee account, log in using your user name and password.

The Take Test page appears.

For details, see About attendee accounts on page 113.

■ If you do not have an attendee account, select Continue without signing up, 
and then click Continue.

6 If you select Continue without signing up, type your registration ID and the 
session password, if required, and then click OK.

The Take Test page appears.

7 Click Take Test.

8 Answer the questions. When finished, click Submit Test.

For more information about answering questions, see Answering questions on 
page 119.
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Taking a test from an invitation email message

If you receive an invitation email message to take a test, you can take the test from 
the email message.

To take a test from an invitation email message:

1 Open the invitation email, and then click the appropriate link.

The Take Test page appears.

2 Click Take Test.

3 Answer the questions.

4 When finished, click Submit Test.

For more information about answering questions, see Answering questions on 
page 119.

Leaving and returning to a test

You can leave a test and return to it later only if the test is pre- or post-session.

If the host specifies a time limit for the test you are taking, remember the following:

■ You must return to the test within the time limit.

■ The duration of your absence counts toward the time limit.

To leave a test temporarily:

1 Click Return to Test Later.

The Leave Test page appears.

2 To confirm your leaving, click Leave Test.

The Session Information page appears.

To return to the test that you left temporarily:

Follow the same steps as if you were to take the test for the first time. For details, see 
Taking a pre- or post-session test on page 113.

Taking an in-session test

If you want to ... See ...

get an overview of taking an in-session test About taking an in-session test on page 117

take an in-session test Taking an in-session test on page 117
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About taking an in-session test

During the training session that you are attending, the presenter may conduct 
in-session tests.

Before the presenter starts the test, there may be a waiting period that allows you to 
view test information, such as the test title and description, time limit, if any, 
number of questions, and the maximum score, if any.

The following figure shows an example of the page that appears in a new Web 
browser on your computer while you wait for the presenter to start the test.

Taking an in-session test

To take an in-session test, follow the steps:

1 Once the presenter starts the test, a page appears on which you can answer the 
questions.

Note When taking an in-session test, you cannot leave and return to the test 
later.

2 When finished, click Submit Test.

For more information about answering questions, see Answering questions on 
page 119.
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Taking a recorded session test in a Presentation 
Studio presentation

About taking a recorded session test

During the recorded training session that you are viewing, there may be tests within 
the presentation if it is a Presentation Studio presentation.

When you arrive at a test in the recorded session, the Take Test page appears, which 
shows test information, such as the test title and description, time limit, if any, 
number of questions, and the maximum score, if any. You have the option to take 
the test now or continue with the presentation and return to the test at a later time. 
You can take each test only once.

There are also fields for you to enter your name and email address. These fields will 
be populated if you have already registered for the recorded session or have already 
taken a test during the session.

The following figure shows an example of the Take Test page.

Taking a recorded session test

To take a recorded session test, follow the steps:

If you want to ... See ...

get an overview of taking a recorded session 
test

About taking a recorded session test on 
page 118

take a recorded session test Taking a recorded session test on page 118
118



Chapter 14: Taking a Test
1 On the Take Test page, click Take Test.

A page appears on which you can answer the questions.

2 When finished, click Submit Test.

For more information about answering questions, see Answering questions on 
page 119.

Leaving and returning to a recorded session test

You can leave a test and return to it later during a recorded session.

If a time limit is specified for the test you are taking, remember the following:

■ You must return to the test within the time limit.

■ The duration of your absence counts toward the time limit.

To leave a test temporarily:

1 Click the Save Answers button to save all of your answered questions.

The button changes to Answer Saved for those questions that you have already 
answered.

For more information about answering questions, see Answering questions on 
page 119.

2 Click the arrows or another slide in the presentation to change slides.

To return to the test that you left temporarily:

Click the slide that contains the test to resume the test. All answers that have been 
saved will remain answered.

Answering questions

Answering questions

Answering questions in a test requires that you select or type your answers by using 
your mouse.

To learn how to answer each type of question, see the following table.

If you want to ... See ...

learn how to answer questions in a test Answering questions on page 119

know how to save your answers and navigate 
in a test

Saving answers and navigating in a test on 
page 120
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Saving answers and navigating in a test

The ways you navigate in a test and save your answers differ, depending on how the 
questions are displayed. The host who creates a test can choose either of the 
following displays:

■ All questions in one page—Displays test information, instructions, if any, and 
all questions in one page.

To view more questions on the page, use the scroll bar in your browser.

To save all the answers you have not saved, click any Save Answers button.

Each question is indicated by one of the following buttons, so you know which 
questions you have or have not answered.

■ One question per page—Each page displays only one question. The first page 
displays the test information; the second page displays the instructions, if any.

To navigate between questions, use the Control Panel, which appears in each 
page. Moving to any question saves the answers you previously selected or typed. 

The following figure shows the Control Panel.

If you want to ... Do the following ...

answer a question that requires you to 
select one correct answer

Click the radio button for your choice.

Note To click, press your mouse once 
and then release it.

change the answer you selected in a 
question that requires you to select one 
correct answer

Click a different radio button.

answer a question that requires you to 
select more than one correct answer

Click the check boxes for your choices.

cancel the answers you selected Click the selected check boxes again.

answer an essay or fill-in-the-blanks 
question

Type your answer in the text box.
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To move to a question, do either of the following:

Choose the question in the drop-down list.

Click Next Page or Previous Page to move to the question.

Viewing test results

About viewing test results

You can click View Results on the Session Information page or, for a recorded 
session, on the Test Submitted page, to view your test results. You can also click a 
link sent via email to view your test results if you receive grade reports from the 
host.

If the test contains no essay or fill-in-the-blanks questions that need manual 
scoring, your test results are available once you submit your answers. In this case, 
you can click the view the results link to view your test results. See the following 
figure for an example.

For a recorded session test, you can view results or continue with the presentation 
by clicking the appropriate button.

If you want to ... See ... 

get an overview of viewing test results About viewing test results on page 121

view results of a test that contains essay or 
fill-in-the-blanks questions

Viewing results of a test that requires manual 
scoring on page 122
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Viewing results of a test that requires manual scoring

If a test contains essay or fill-in-the-blanks questions that require manual scoring, 
you must wait for the instructor to complete scoring.

For in-session, pre-, or post-session tests, check the Session Information page on 
your Training Center Web site for your test results, or the host’s email message that 
contains your grade reports. For recorded session tests, your results will be emailed 
to you when they are ready.

To access the Session Information page, see About the Session Information page on 
page 110.

Note

■ Before the test ends, and if the scoring is completed, you can view your score and 
grade, if assigned.

■ After the test ends, and if the scoring is completed, you can view detailed results, 
including your score, your grade, if assigned, correct answers, and the 
instructor’s comments.
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Viewing a Recorded Training 
Session

About viewing a recorded training session
If a training session host publishes a recorded training session on your Training 
Center Web site, you can view the recording. A host may require that you do one or 
both of the following to view a recorded training session:

■ Enroll to view a recorded training session. In this case, you must provide your 
name, email address, and any other information that the host requires.

■ Provide a password. In this case, you must obtain the password from the host.

To view a recorded training session, you must use either the WebEx Player or the 
Windows Media Player 9 (or higher) to view it, depending on how the training 
session was recorded.

Your Training Center Web site automatically downloads WebEx Player to your 
computer the first time you view a recorded training session. A WebEx Player is 
available for the Windows operating system. If you have a user account, you can 
also download WebEx Player for Windows from the Support page on your Training 
Center Web site.

If you want to... See...

get an overview of viewing a recorded training 
session

About viewing a recorded training session on 
page 123

view a recorded training session Viewing a recorded training session on 
page 124

take a recorded session test in a Presentation 
Studio presentation

Taking a recorded session test in a 
Presentation Studio presentation on page 118
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If the recording contains a Presentation Studio presentation, you will need the 
Windows Media Player 9 (or higher) on your computer to view it, as well as the 
following:

■ Windows 98, NT4, 2000, XP

■ Internet Explorer 6 (recommended), Netscape 7.1, Netscape 7.2, Firefox 1.0 or 
later

■ Flash Player 7 (recommended but not required if recording includes Flash 
content)

■ Sound card with proper driver installed

Viewing a recorded training session
You can view a recorded training session by streaming it from your Training Center 
Web site, or by clicking the recording URL link that the host has sent to you. Once 
you select a recording to view, your Training Center Web site automatically 
downloads WebEx Player to your computer, and then plays the recording. If the 
recording contains a Presentation Studio presentation, you will need the Windows 
Media Player 9 (or higher) to view it.

To view a recorded training session:

1 If the host requires that you have a user account to view a recording, log in to 
your Training Center Web site.

2 On the navigation bar, expand Attend a Session.

3 Click Recorded Sessions.

4 Select a recording and click View.

■ If viewing the recording requires a password or access code, enter the 
password or access code that the host gave to you, and then click OK.

■ If viewing the recording requires registration, provide the required 
information on the registration form that appears, and then click Register.

■ If viewing the recording requires payment information, provide the required 
information and any coupon codes on the registration form that appears, and 
then click Register.

The WebEx Player or Presentation Studio Viewer opens and begins playing the 
recording.

To access a recording URL from an email, instant message, or another Web site:

1 Click the recording URL link that was provided by the host.

The Recording Information page appears.
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2 Click View.

■ If viewing the recording requires a password or access code, enter the 
password or access code that the host gave to you, and then click OK.

■ If viewing the recording requires registration, provide the required 
information on the registration form that appears, and then click Register.

■ If viewing the recording requires payment information, provide the required 
information and any coupon codes on the registration form that appears, and 
then click Register.

The WebEx Player or Presentation Studio Viewer opens and begins playing the 
recording.

3 Optional. To download the recording, click Download and save the file to your 
computer.
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Information Resources

Obtaining more information and assistance
Your Training Center Web site provides numerous resources for learning about 
features, getting answers to questions, and contacting WebEx. 

To get started, on the navigation bar on the left side of the page, click the icon next 
to Assistance to display the Assistance menu.

If you want to... See...

get an overview of available information Obtaining more information and assistance on 
page 127

learn about features on the Support page About the Support page on page 128

learn about features on the Training page About the Training page on page 129

Click this icon to expand the Assistance menu
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Accessing the Support page

To learn about the kinds of support offered, go to the Support page. From your 
Training Center Web site, on the left navigation bar, click Assistance > Support.

About the Support page

On the Support page, you’ll find many links to information about products, 
services, getting help, and contacting WebEx. 

Click Support for information about 
contacting technical support, getting 
help, and viewing documents

If you want to... Use these tools...

contact technical support Under Contact Us:

■ Click the email link to send a message to the 
Help desk

■ Use the phone numbers listed to speak with a 
technical support representative

send a comment or feature request Under Contact Us, click the Feedback Form link 
and complete form

Alternatively, you can send an email message to: 
feedback@webex.com

learn about using WebEx products and 
services

Under Documentation:

■ Click the links to view release notes and 
frequently asked questions

■ Click a link for any document listed in this 
section. These documents are available in pdf 
format, so you can easily print them

You’ll find short guides to help you get started as 
well as comprehensive user guides. 

download products that help you run 
effective training sessions

Under Downloads:

Click any of the links to download tools, such as:

■ Training Manager

■ Access Anywhere

■ WebEx Recorder, WebEx Player, and WebEx 
Recording Editor 

■ WebEx Universal Communications Toolkit 

■ My WebEx Integration to Outlook
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Attending WebEx training

Go to the Training page to learn about training opportunities. From your Training 
Center Web site, on the left navigation bar, click Assistance > Training.

About the Training page

You can use our self-pace training, enroll in a training session, or work with a 
consultant to create personalized training for you or your group.

Providing feedback about WebEx documentation
If you have comments about WebEx documentation, please send an email message 
to docs@webex.com.

In your email message, please specify the section to which your comment applies. If 
you would like to receive a response to your comments, please include your name 
and contact information in your message.

We look forward to hearing from you.

Click Training to learn about courses 
that are available or to contact the 
training team

If you want to... Use these tools...

take part in a training course Under Attend Training, click the link to the 
Online Training Registration page.

You will learn about self-paced and 
instructor-led courses. You can also print a 
course catalog from the registration page

learn about other training options, such as 
finding a consultant or specialized training

Under Take Advantage of all our Training 
Services, follow the links to learn about training 
courses and other services, such as:

■ WebEx University: A full suite of engaging, 
interactive classes 

■ WebEx Assist Services: Working with a team 
to provide hands-on assistance and 
production with any WebEx training session

contact the WebEx training team Under Contact Us:

■ Click the email link to send a message to the 
training team.

■ Use the phone numbers listed to speak with 
someone about your training options
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Glossary

A

Access Anywhere
A service on your Training Center Web site that lets you access a computer from a 
remote location.

Access Anywhere Agent
Software that you can install on a computer, to allow you to remotely access the 
computer's desktop or applications.

Access Anywhere Server
A server that supports an Access Anywhere session that is, the connection between 
a local computer and a remote computer.

ActiveTouch Document Loader
A printer driver that converts a document or presentation into a format that you 
can open in the content viewer in the Session window. When you share a document 
or presentation during a training session, the ActiveTouch Document Loader prints 
it to a file, and then displays it in the content viewer.

application sharing
The act of sharing an application on your computer during a training session. All 
participants can view the shared application, which appears in a sharing window on 
their screens. Participants can see all of your activity in the application.

annotation mode 
During a training session, a mode that lets you use your mouse pointer to annotate 
the shared software.

attendee
A participant who primarily views information that a presenter shares in a training 
session. An attendee also can perform other tasks according to his or her privileges.

attendee ID
An identification (ID) number that Training Center assigns to you once you join a 
training session that includes an integrated teleconference. You must provide this 
ID when joining a call-in teleconference so the teleconferencing service can match 
your call with your name in the participant list.
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attendee privileges
See privileges.

authorized user
A user who has an account on your Training Center Web site and uses his or her 
user name and password to log in to the service.

B

breakout session
A private application or desktop sharing session, away from the main training 
session, which allows participants to collaborate and interact with presenters or 
other students in smaller groups.

C

call-back teleconference
A telephone conference in which a participant provides his or her phone number 
when joining a training session. The teleconferencing service calls the participant 
back and instructs the participant on how to join the teleconference.

call-in teleconference
A telephone conference in which a participant calls a phone number when joining 
a training session. When a participant calls the phone number, a voice response 
system guides the participant through the process of entering the training session 
number and his or her caller ID to join the teleconference.

chat
A method of communication by which training session participants send real-time 
text messages to each other.

company address book
A list of contacts in your personal address book that your site administrator 
maintains for your organization. 

contact group
In your personal address book, a list of two or more contacts for which you provide 
a common name. Contact groups allow you to quickly invite several contacts to a 
training session all at once.

content
A document, presentation, or other type of content that a presenter shares in the 
content viewer.
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content viewer
The content area on the left side of the Session window. When a presenter shares a 
document, presentation, or whiteboard, it appears in the content viewer.

D

desktop sharing
The act of sharing your computer desktop during a training session. All participants 
can view the shared desktop, which appears in a sharing window on their screens. 
Participants can see all of your activity on your desktop.

Document Manager
An application that you can use outside a training session to view a document, 
presentation, or whiteboard that you saved in the Universal Communications 
Format (UCF). Double-clicking a UCF file opens the Document Manager on your 
computer.

document and presentation sharing
Refers to sharing any type of document or presentation in the content viewer 
during a training session. 

dual-mode voice conference
A voice conference in which both a teleconference and an Integrated VoIP 
conference are in progress concurrently. To listen to audio, a participant can use 
either a phone or speakers attached to his or her computer. To speak, a participant 
can use either a phone or microphone attached to his or her computer.

E

emoticons
Icons that attendees can use to convey voice inflections, facial expressions, and 
other gestures.

F

Feedback
A feature of Training Center that allows presenters to obtain quick yes-or-no 
attendee responses to questions that they ask, or receive attendees’ feedback on the 
pace of their presentations.
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floating icon tray
A small toolbar that appears when you share software. On the floating icon tray, 
icons represent minimized panels that you can open during the sharing session, 
without having to return to the main Session window.

G

G.723 
An international standard for compressing audio data and defining the data format 
Available in WebEx Recorder.

H

Hands-on Lab
Sessions within a training session that simulate a physical computer lab, allowing 
participants to use computers remotely for hands-on learning and practice.

host
A participant who is primarily responsible for scheduling, starting, controlling 
access to, and ending a training session. A host must have a host account.

host indicator
The text (host), which appears in the participants list, to the right of the host’s 
name.

host key
A number that Training Center assigns to a training session host. If a host transfers 
the host role to an attendee, or otherwise loses control of a training session, the 
original host can use the host key to reclaim the host role.

I

icon tray
The area above the panels in the Session window. On the icon tray, icons represent 
minimized panels that you can open.

Info tab
A standard tab that appears by default in the content viewer. The Info tab contains 
basic information about a training session and its teleconference. 
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instant training session
An impromptu training session that you start immediately, without scheduling it 
first. Instant training sessions require fewer setup options than scheduled training 
sessions.

integrated teleconference
A teleconferencing service that is included with Training Center, rather than a 
third-party teleconferencing service. An integrated teleconference can be either a 
call-in or call-back teleconference.

Integrated VoIP
A type of voice conference that allows participants to communicate over the 
Internet using voice over IP (VoIP) and a computer with a sound card, speakers, 
and a microphone.

L

local computer
The computer that you use to access a remote computer during an Access 
Anywhere session.

M

MediaTone
Technologies that enhance the multimedia capabilities of Training Center. For 
example, MediaTone includes the Universal Communications Format (UCF), 
Access Anywhere, and multiple document sharing capabilities of Training Center.

My WebEx 
An area on your Training Center Web site in which you can access various user 
account features, such as your user profile, list of meetings, online address book, 
personal folders, One-Click Meetings, and so on.

O

One-Click Meeting
An online session that you can start at any time, as often as you want, by clicking a 
shortcut on your computer. You can set up a One-Click Meeting using the 
One-Click Meeting Wizard, which is available in the My WebEx area of your service 
Web site.
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P

panel
A group of controls that resides in an area of the Session window, to the right of the 
content viewer—for example, the Participants panel.

panelist
An attendee who participates in a discussion to which other attendees listen, 
responds to chat messages, annotates shared documents, opens and closes polls, 
and views and answers attendees’ questions in Q & A sessions.

participant
Refers collectively to all individuals in a training session, including the host, 
presenter, and attendees.

participants list
The list of participants on the Participants panel in the Session window. Each name 
in the participant list represents a single computer connection to the training 
session.

PCM
Abbreviation for pulse-coded modulation. The audio format standard for 
CD-ROM. Available in WebEx Recorder.

personal address book
An online address book that you maintain on your Training Center Web site. Your 
personal address book can contain a personal contacts list, contact groups, and a 
company address book.

personal contacts list
A list of individual contacts that you have added to your personal address book. If 
you have a Microsoft Outlook address book or contacts folder, you can import its 
contacts to this list of contacts.

personal folders
Storage space for your files on your Training Center Web site. If you store files in 
your folders, you can access them from any computer that is connected to the 
Internet. You can also share your folders so visitors to your Personal Meeting Room 
page can access the files in your folders.

Personal Meeting Room
A page on your Training Center Web site that lists only the training sessions for 
which you are the host. If you provide others with the personal URL for this page, 
they can obtain information about your scheduled training sessions, join your 
training sessions in progress, and share the files in your personal folders to which 
you provide access.
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personal URL
The Web address for your Personal Meeting Room page.

Player
Software that plays back recordings that you make using the Recorder. Training 
Manager downloads and installs the Player on your computer the first time you 
record a meeting. If you have a user account, you can also download the Player from 
your Training Center Web site.

poll questionnaire
A list of questions or statements that a presenter prepares, to which attendees 
respond by selecting choices or typing answers.

presenter
A participant who provides information to other training session participants; can 
share documents, presentations, applications, desktops, Web browsers, and 
information on a whiteboard with others; or conduct a poll.

presenter indicator
A green symbol of a ball, which appears in the participants list, to the left of the 
name of the participant who is the current presenter.

privileges
A user's capabilities to use specific Training Center features. A host, presenter, and 
attendee each have different privileges in a training session.

Q

question-and-answer (Q & A) sessions
A feature that allows participants in a training session to ask questions and receive 
answers from the host, presenter, or panelists.

R

Recorder
Software that records screen activity in any Windows application or in a training 
session. Training Manager includes an integrated version of the Recorder, which 
you can run during a training session.

Recording Editor 
Software that allows you to edit any recording that was made using Recorder, that 
is, a Recording Format file. Using Recording Editor, you can add, delete, or 
rearrange recorded data; or dub audio.
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recording file
See Recording Format.

Recording Format (WRF)
A file format that comprises audio and images of user actions on a computer screen. 
A user can create a WRF file using the Recorder and edit a WRF file using the 
Recording Editor. A WRF file has a .wrf extension.

remote computer
A computer on which you have installed the Access Anywhere Agent, allowing you 
to access the computer over the Internet, using a local computer.

remote control
Refers to a meeting participant's ability to control an application, desktop, or Web 
browser that a presenter is sharing on his or her computer.

S

SCORM
Sharable Courseware Object Reference Model. Set of technical standards allowing 
Web-based learning systems to find, import, share, reuse, and export learning 
content in a standardized way.

session number 
A unique number that your Training Center assigns to a training session. For an 
unlisted session, participants must provide the session number to attend the 
session.

Session window
The main user interface with which participants interact during a training session. 
The Session window includes the content viewer, menus, toolbars, and panels.

shared content
A document, presentation, or other type of content that a presenter is sharing in the 
content viewer.

shared software 
A general term that refers to the following types of software that a presenter can 
share in a training session: application, desktop, Web browser, and remote 
computer. Shared software appears in a sharing window on participants' screens.

sharing
During a training session, allowing attendees to view or control a document, 
presentation, whiteboard, application, desktop, or Web browser; or view a remote 
computer.
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sharing window
A window that opens on participants' screens, in which a shared software appears.

single-point video
A video mode in which only the presenter, or a participant selected by the presenter, 
can send video images during a training session.

site administrator
An employee of a company who administers that company's Training Center Web 
site. A site administrator can add, modify, and remove user accounts; specify 
options; maintain a company address book for your Training Center service; and so 
on.

speaker indicator
A symbol of a phone or microphone, which appears in the participants list, to the 
left of the name of a participant who is connected in an integrated teleconference or 
Integrated VoIP conference.

streaming 
A technology in which media is sent in a continuous stream over the Internet and 
displayed by a media player as it arrives on a user's computer. With streaming 
media, a user need not wait for his or her computer to download a large file before 
seeing or hearing the media.

T

third-party teleconferencing service
Any teleconferencing service other than the teleconferencing service that Training 
Center provides. You can use any third-party teleconferencing service for a training 
session.

thumbnail viewer
An area that a user can display on the left side of the Session window. The 
thumbnail viewer contains miniature images, or thumbnails, of each page in a 
shared document, presentation, or whiteboard.

training calendar
A calendar on your Training Center Web site that lists training sessions either in 
progress or scheduled. The calendar appears on the Live Sessions page.

Training Manager
Software that provides the Session window and sharing windows during a training 
session. Training Manager includes the Session window and sharing windows 
during a training session.
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U

UCF 
See Universal Communications Format (UCF).

UCF media file
A media file type that you can play in the content viewer during a training session 
or in the standalone Document Manager, including Recording Format (WRF), 
audio, video, Flash, and Web page files.

UCF media object
In a UCF multimedia presentation, an interface element that specifies the location 
of media file and includes controls for playing the file. You can insert media objects 
into a Microsoft PowerPoint presentation, using the Universal Communications 
Toolkit.

UCF multimedia presentation
A Microsoft PowerPoint presentation that contains UCF media files. You can share 
or view a UCF multimedia presentation in the content viewer or the standalone 
Document Manager, and play the media files in it.

UCF rich media
Refers to the following types of UCF media files: Recording Format (WRF), audio, 
video, and Flash.

Universal Communications Format (UCF)
A file type with the extension .ucf, which lets you do the following in a training 
session:

Share multiple documents or presentations simultaneously.

Display slide transitions and animations in Microsoft PowerPoint presentations.

Share and play UCF media files.

Universal Communications Toolkit
An add-in program for Microsoft PowerPoint that lets you insert rich media files 
into a PowerPoint presentation. You can then share the presentation and play the 
media files during a training session.

unlisted training session
A scheduled training session that does not appear on your Training Center Web site 
or on the host's Personal Meeting Room page. To join an unlisted training session, 
attendees must provide a training session number.

user name
A unique name that a user must provide, along with a password, to access a user 
account on your Training Center Web site.
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V

voice conference
Collectively refers to any teleconference or Integrated VoIP conference that may be 
in progress during a training session.

voice over IP (VoIP)
A real-time voice communications technology by which computers send voice 
information in digital form over the Internet, rather than in the circuits of the 
traditional public telephone system.

W

Web browser sharing
The act of sharing your Web browser during a training session. All participants can 
view the shared Web browser, which appears in a sharing window on their screens. 
As you navigate to other Web pages in your browser, all participants “follow along” 
in their sharing windows.

webcam
A video camera attached to a computer that provides video images that a user can 
view on a Web site.

WebEx Document Manager
See Document Manager.

WebEx MediaTone Network (WMN)
A global network that provides secure, reliable, real-time communications services 
with predictable performance to your Training Center Web site. The network 
delivers optimal performance to Web sites by routing communications through the 
nearest WebEx hub.

WebEx Player
See Player.

WebEx Recorder
See Recorder.

WebEx Recording Editor
See Recording Editor.

WebEx Recording Format (WRF)
See Recording Format.
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WebEx teleconferencing service
See teleconferencing service.

whiteboard
A workspace in the Session window that allows participants to draw and type 
simultaneously.
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Symbols

.txt files
for chat messages 85
opening saved chat files 86

.ucf files
opening 68
saving documents 67
saving presentations 67
saving whiteboards 67

A

adding
pointers to pages 66
pointers to slides 66
pointers to whiteboards 66

annotating
using Highlighter tool 62
using Text tool 63
shared documents. See  annotations, on 

shared documents
shared presentations.  See  annotations, on 

shared presentations
annotating, shared software

requesting control 74
using annotation tools 75

annotation color
changing for shared document 64
changing for shared presentation 64
making visible on dark background 64
making visible on light background 64

Annotation Color tool
overview 62

annotation control
of shared software, requesting from presenter 

74
annotation tools, for shared documents

Annotation Color tool, overview 62
Eraser tool, overview 62
Highlighter tool, overview 62
Line tool, overview 62
Pointer tool, overview 62
Rectangle tool, overview 62
Text tool, overview 62

annotations, on shared documents
making 62
making visible on dark background 64
making visible on light background 64
selecting color 64
selecting font 64

annotations, on shared software
stopping 76
using tools 75

answering indicator
answering in progress in Q & A 104

application, shared
closing and reopening window in which it ap-

pears 77
controlling full-screen view 72
requesting annotation control 74
requesting remote control 73
resizing view 72
switching between shared view and main win-

dow 77
viewing 71
zooming in or out 72

asking
for help in Hands-on Lab 95

asking questions
in Q & A sessions 102

asking questions in Q & A sessions
overview 101

asking to speak
in Integrated VoIP conference 40
in teleconference 48

assigning sounds
to incoming chat messages 83

assistance
obtaining 127
overview 127

Audio Setup Wizard for Integrated VoIP, using 37
audio, for Integrated VoIP

adjusting with Audio Setup Wizard 37

B

backgrounds
annotating on dark 64
annotating on light 64
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C

call-back teleconference
joining 46

call-in numbers, global 46
call-in teleconference

joining 46
chat

overview 81
chat messages

assigning sounds 83
opening file for 86
printing 84
saving 85, 86
sending 82

checking
status of unanswered questions 103

checking system for UCF compatibility 19
clearing

all pointers on shared documents 67
your pointers on shared documents 67

closing
sharing window 77

color, selecting for annotating
documents 64
presentations 64
whiteboards 64

computer, setting up
Training Manager 17

computers in Hands-on Lab
connecting to 90
disconnecting from 97

connecting
to computer in Hands-on Lab 90

contacting WebEx 128
course material

downloading 24

D

dark background,
annotating on 64

date
selecting on training session calendar 2

daylight savings time
adjusting training session times 6

deleting
annotations on shared software 75

desktop, shared
closing and reopening window in which it ap-

pears 77
controlling full-screen view 72
requesting annotation control 74

requesting remote control 73
resizing view 72
switching between shared view and main win-

dow 77
viewing 71
zooming in or out 72

displaying
any slide or page 52
next page 52
next slide 52
previous page 52
previous slides 52

documents, shared
annotating 61
clearing your pointers 67
printing pages 69
saving to file 67
using pointers 66

downloading
course material 24
published files during a training session 79
Training Manager 15

drawing annotations
on shared documents 61
on shared presentations 61

E

emoticons
using in feedback 106

enlarging
size of shared software 72

eraser
using to delete annotations on shared soft-

ware 75
Eraser tool

overview 62
erasing

all pointers on shared documents 67
your pointers on shared documents 67

exchanging files
during a training session 79

F

feedback
overview of 105
providing 106
using emoticons in 106

files
.ucf (Universal Communications Format) for 

multimedia 67
.wav for chat sounds 83
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exchanging during a training session 79
for chat 85
for course material, downloading before a ses-

sion starts 24
playing sounds for chat messages 83

font
selecting for annotations 64

full-screen view
pages 59
slides 59
whiteboards 59

full-screen view, controlling
for shared software 72

G

global call-in numbers 46

H

Hands-on Lab
asking for help 95
chatting in 94
connecting to computers 90
disconnecting from computers 97
ending Integrated VoIP conference 93
ending teleconference 93
leaving 97
Manager window 93
passing control of computer 96
starting Integrated VoIP conference 92
starting teleconference 93
transferring files in 95
using Integrated VoIP conferencing 91
using teleconferencing 91

help
asking for in Hands-on Lab 95

Highlighter tool
overview 62

I

information about training sessions, obtaining 30
installer

for Training Manager 17
installing

Training Manager 17
Integrated VoIP conference

adjusting speaker and microphone volume 39
adjusting voice buffer length 39
asking to speak 40
Audio Setup Wizard, using 37

ending in Hands-on Lab 93
joining 37
leaving 44
microphone, using to speak 40
muting and unmuting your microphone 39, 43
muting and unmuting your speakers 39
participating, overview 36
starting during Hands-on Lab 92
system requirements 36

J

joining
Integrated VoIP conference 37
teleconference 46

joining training session
from email message 26
listed 26
overview 21
unlisted 28

L

leaving
Hands-on Lab 97
Integrated VoIP conference 44
teleconference 49

Line tool
overview 62

listed training session
joining 26

live sessions calendar
overview 31
refreshing 33
searching for a training session in 32
selecting time zone on 33
sorting 32

M

magnifying
pages 56
slides 56
whiteboards 56

manual installer
Training Manager 17

media players for UCF media files
checking if installed on computer 19

meeting calendar
Daily view 2
Monthly view 2
opening 2
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Today view 2
Weekly view 2

microphone
adjusting volume in Integrated VoIP confer-

ence 39
muting and unmuting your own in Integrated 

VoIP conference 39, 43
muting and unmuting your own in teleconfer-

ence 47
specifying setup for Integrated VoIP 37, 39
using Audio Setup Wizard to adjust for Inte-

grated VoIP 37
using in Integrated VoIP conference 40

moving
between pages in document 52

muting
speakers in Integrated VoIP conference 39
your microphone in Integrated VoIP confer-

ence 39, 43
your microphone in teleconference 47

O

opening
chat file 86
meeting calendar 2
saved documents 68
saved presentations 68
saved whiteboards 68
training session calendar 2

overview
asking questions in Q & A sessions 101

P

pages
magnifying 56

pages, of shared documents
adding pointers 66
annotating 62, 63
clearing pointers 67
full-screen view 59
moving to previous 52
printing 69
selecting color for annotating 64
synchronizing view 60
zooming in 53
zooming out 53

pages, of shared documents, moving to next 52
passing control, of Hands-on Lab computer 96
pointer

using on shared software 75
Pointer tool

overview 62
pointers, adding to

shared document 66
shared presentation 66
shared whiteboard 66

pointers, clearing from
shared document 67
shared presentation 67
shared whiteboard 67

poll questionnaires
filling out 99

poll results
viewing as attendee 99

polls
participating in 99

pre- or post-session test 113
Presentation Studio 124
presentations

viewing 51
presentations, shared

annotating 61, 62
clearing your pointers 67
printing slides 69
saving to file 67
using pointers 66

printing
chat messages 84
pages in shared documents 69
shared whiteboards 69
slides in shared presentations 69

Q

Q & A
in-progress indicator 104

Q & A panel
opening, closing tabs 102

Q & A sessions
asking questions 102

questions
asking in Q & A sessions 102

R

recorded training sessions
viewing 124

Rectangle tool
overview 62

reducing
size of shared software 72

refreshing
list of sessions 33

refreshing training session calendar 5
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registering for a training session 22
remote computer, shared

closing and reopening window in which it ap-
pears 77

controlling full-screen view 72
resizing view 72
switching between shared view and main win-

dow 77
viewing 71
zooming in or out 72

remote control, of shared software
requesting from presenter 73

removing
Training Manager 18

requirements, system 124
resizing

view of shared software 72

S

saving
chat messages 85
copy of chat messages 86
documents, shared 67
presentations, shared 67
shared documents 67
shared presentations 67
shared whiteboards 67

searching
for a training session in list of sessions 32
for session on training session calendar 4

sending
chat messages 82

setting up
Training Manager 17

sharing applications. See application sharing.
sharing desktops. See desktop sharing.
sharing window

closing 77
overview 71
returning to 77

size
of shared software, changing 72

slides, in shared presentations
adding pointers 66
annotating 62, 63
clearing pointers 67
full-screen view 59
magnifying 56
moving to next 52
moving to previous 52
printing 69
selecting annotation color 64

synchronizing view 60
zooming in 53
zooming out 53

software, shared
controlling full-screen view 72
resizing view 72
returning to main when viewing 77
viewing 71

sorting
list of sessions 32
training session calendar 4

sounds
assigning to incoming chat messages 83

speaker, in teleconference
determining 48

speakers
adjusting volume in Integrated VoIP conference 

39
specifying setup for Integrated VoIP 37, 39
using Audio Setup Wizard to adjust for Integrat-

ed VoIP 37
status of questions

checking My Q & A tab 103
checking, overview 103

stopping
annotations on shared software 76
application sharing 77
desktop sharing 77
remote application sharing 77
remote desktop sharing 77
Web browser sharing 77

support
obtaining 128
overview 127

Support page
accessing 128

support, obtaining 127
switching

between sharing window and main window 77
synchronizing

view of pages 60
view of slides 60
view of whiteboard 60

system requirements 124
Integrated VoIP 36
Training Manager 16

T

tabs
opening, closing on Q & A panel 102

Taking 113
technical support, obtaining 127
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teleconference
asking to speak 48
determining who is speaking 48
ending in Hands-on Lab 93
joining 46
leaving 49
muting and unmuting your microphone 47
participating, overview 45
starting during Hands-on Lab 93

test information 111
Text tool

overview 62
typing annotations 63

thumbnails
of documents and presentations 58

time zone
selecting on list of sessions 33
selecting on training session calendar 6

tools, annotation
using on shared software 75

Training Manager
setting up 15, 16, 17
system requirements 16
uninstalling 18

training service
setting up Training Manager 16
setting up Training Manager, overview 15

training session calendar
opening 2
overview of 1
refreshing 5
searching for session 4
selecting a date on 2
selecting a time zone 6
sorting 4
when training sessions are removed from 1

training session password
receiving in an email message 21

training sessions
joining 21
joining listed 26
joining unlisted 28
obtaining information about 30
registering for 22
searching for in list of sessions 32
searching for on training session calendar 4
viewing agenda for 30

transferring
control of a computer in Hands-on Lab 96
files during a training session 79

typing annotations on shared
documents 63
presentations 63
whiteboards 63

U

UCF
checking system compatibility 19

UCF media files
verifying that your computer can play 19

uninstalling
Training Manager 18

unlisted session number
providing to join a training session 28

unlisted training session
joining 28

unmuting
speakers in Integrated VoIP conference 39
your microphone in Integrated VoIP confer-

ence 39, 43
your microphone in teleconference 47

V

viewing
documents 51
information about training session 30
meeting calendar 2
poll results as attendee 99
presentations, shared 51
recorded training sessions 123, 124
shared application 71
shared desktop 71
shared desktops 71
shared remote computer 71
shared Web browser 71
thumbnails of presentations and documents 

58
training session calendar 2
whiteboards 51

viewing documents and presentations
overview 51

voice buffer length, adjusting for Integrated VoIP 
39

W

Web browser plug-in
for training services 17

Web browser, shared
closing and reopening window in which it ap-
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